Contents

Chapter 1: Introduction ................................................................................. 1-1
How to Use this Guide.................................................................................... 1-1
Chapter Summary .......................................................................................... 1-2

Chapter 2: Getting Started .......................................................................... 2-1
Sage CRM Requirements ............................................................................... 2-1
  Licensing.................................................................................................... 2-1
System Requirements .................................................................................. 2-1
  Sage CRM ............................................................................................... 2-1
  Sage 300 ERP .......................................................................................... 2-2
  LanPak Licenses ...................................................................................... 2-3
  Client Workstations .................................................................................. 2-3
Now You Can.................................................................................................. 2-4

Chapter 3: Sage CRM Installation ................................................................. 3-1
Installing Sage CRM ..................................................................................... 3-1
Installing Sage 300 ERP Accounting Integration for Sage CRM ................. 3-3
Now You Can.................................................................................................. 3-5

Chapter 4: Configuring Servers and Server Access Permissions .................... 4-1
Accessing Server Resources through a Browser ........................................... 4-1
Working with Internet Information Services Manager ................................... 4-1
  Restarting IIS to Reflect Security Changes ................................................. 4-2
  Checking the IIS Anonymous Access Account .......................................... 4-2
Requirements for IIS 6.0 on Windows 2003 R2 ............................................. 4-5
  Configuring IIS for Sage 300 ERP Integration .......................................... 4-5
Setting Up Sage CRM and Sage 300 ERP on a Single Server ....................... 4-7
  Setting Directory Access Rights for NTFS ................................................ 4-8
Allowing Sage CRM to Connect to Sage 300 ERP Data ................................ 4-9
Setting Registry Permissions for the Internet Guest Account ......................... 4-10
Setting Path Statements............................................................................... 4-13
Chapter 5: Sage 300 ERP Integration (E/W) Component ... 5-1

Overview of Steps ................................................................. 5-1
Installing the E/W Integration Component ................................. 5-2
Activating Sage CRM Integration within Sage 300 ERP .................. 5-2
Selecting Integration and Notification Options ......................... 5-3
Setting Up Sage 300 ERP Workstations ................................. 5-5
Now You Can............................................................................ 5-6

Chapter 6: Setting Up Sage 300 ERP Integration in Sage CRM ... 6-1

Logging On to Sage CRM ..................................................... 6-1
Selecting Integration Settings ................................................. 6-2
Synchronizing Tables .......................................................... 6-3
Resetting Currency in New Installations ................................ 6-4
  Currency Troubleshooting .................................................. 6-5
Importing Customer, Vendor, and National Account Relationships from Sage 300 ERP ................................. 6-5
Converting Existing Sage 300 ERP O/E Quotes and Orders ........ 6-7
  Conditions for Successful Conversion ................................ 6-8

Now You Can... ........................................................................ 6-8
Chapter 7: Using Sage CRM with Sage 300 ERP

Overview .......................................................... 7-1
Integration Changes to Sage CRM Screens .................. 7-1
Sage CRM Tabs and Screens Added During Integration .. 7-2
Changes to Existing Sage CRM Screens .................... 7-5
Viewing Company and Opportunity Information ............ 7-6
Logging On to Sage CRM ....................................... 7-6
Specifying the Number of Rows that Appear in the Grid ... 7-6
Viewing and Modifying Company Information ............... 7-7
Viewing Company Tabs ........................................... 7-7
Specifying Sage 300 ERP A/R and A/P Person and Address Types ........................................ 7-8
Viewing and Modifying Optional Fields ....................... 7-8
Viewing Customer and Vendor Aging and Statistical Information ........................................ 7-9
Viewing and Modifying Opportunity Information .......... 7-11
Viewing Opportunity Tabs ....................................... 7-11
Viewing and Modifying Opportunity Stage and Status .... 7-12
Viewing Opportunity Forecast and Totals .................... 7-13
Importing National Accounts .................................... 7-14
Changing Customer and Vendor Numbers ................... 7-15
Promoting a Customer or Vendor to Sage 300 ERP ........ 7-15
Promoting a Company .......................................... 7-15
Changing a Customer or Vendor Link ......................... 7-17
Looking Up Inventory Items .................................... 7-17
Creating and Working with O/E Quotes and Orders ....... 7-20
Creating a New Quote .......................................... 7-20
Viewing and Editing Existing Quotes ......................... 7-24
Promoting Quotes to an Order .................................. 7-25
Creating a New Order .......................................... 7-27
Viewing and Editing Existing Orders ......................... 7-30
About Sales Splits .............................................. 7-31
Using Sage 300 ERP Inquiry .................................... 7-31
Order Entry (O/E) Inquiry ....................................... 7-32
Viewing, Modifying, or Creating Order Entry Transactions ........................................ 7-32
Creating a New Sales Order .................................... 7-38
Viewing Credit/Debit Notes ..................................... 7-39
Chapter 1
Introduction

Sage 300 ERP Accounting Integration for Sage CRM creates a link that enables Sage CRM and Sage 300 ERP to share information as it is entered into either program.

After integration, front-office personnel can create customer quotes and orders in Sage CRM and then promote those quotes and orders to Sage 300 ERP. As quotes and orders are processed, both systems are updated, preventing redundant data entry and enabling front-office and back-office personnel to view information that is current and correct.

This guide describes how to:

- Install Sage CRM 7.1
- Integrate Sage CRM 7.1 with Sage 300 ERP 2012
- Use Sage CRM features that are added during integration

Sage ERP Accpac has become Sage 300 ERP. All references to Sage ERP Accpac (version 6.0) and Sage Accpac ERP (version 5.6) have been changed to Sage 300 ERP.

How to Use this Guide

The first six chapters of this guide are for Sage CRM implementers. Chapter 7, “Using Sage CRM for Sage 300 ERP,” is for Sage CRM users.

We assume that implementers:

- Have experience implementing and troubleshooting Sage CRM installations.
- Understand Sage 300 ERP installation and setup.
- Have experience working with Sage 300 ERP.

We assume that users are familiar with web browser software and have experience working with Sage 300 ERP.

Note: Sage CRM 7.1 can be integrated only with Sage 300 ERP version 6.0 or 2012 (6.1).
Chapter Summary

The table below gives a summary of each chapter in this guide.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>2: Getting Started</td>
<td>Requirements for installing Sage CRM and integrating it with Sage 300 ERP.</td>
</tr>
<tr>
<td>3: Sage CRM Installation</td>
<td>How to install Sage CRM with the Sage CRM integration component.</td>
</tr>
<tr>
<td>4: Configuring Server Access Permissions</td>
<td>How to configure the Sage CRM and Sage 300 ERP servers for Sage 300 ERP integration.</td>
</tr>
<tr>
<td>5: Sage 300 ERP Integration (E/W) Component</td>
<td>How to install the Sage 300 ERP integration component.</td>
</tr>
<tr>
<td>6: Using Sage CRM for Sage 300 ERP</td>
<td>How to work with Sage CRM and perform Sage 300 ERP administration tasks.</td>
</tr>
<tr>
<td>7: Where to Now</td>
<td>Where to find more information on working with Sage CRM.</td>
</tr>
</tbody>
</table>
Chapter 2
Getting Started

In this chapter you will learn about:

- Sage CRM requirements.
- System requirements for the Sage CRM server, Sage 300 ERP server, and Sage CRM workstations.

Sage CRM Solo

Sage CRM Solo is only supported in Sage CRM 7.1C or later.

Sage CRM Requirements

Licensing

Before you install Sage CRM, ensure that your Sage CRM license includes Sage 300 ERP Integration.

System Requirements

This section lists the recommended minimum software and hardware requirements for running Sage CRM and Sage 300 ERP. For more information on recommended server specifications, refer to the Sage CRM Technical Specification and the Sage CRM System Administration Guide.

If you are using Windows 2008, refer to the section “Running Sage CRM Integrated with Sage 300 ERP on Windows 2008” in Chapter 4.

Sage CRM

- Windows Server 2003 R2 or 2008 with the latest service packs. Note that Sage CRM supports Windows Vista and Windows 7 only as client operating systems.
- Microsoft SQL Server 2005 or 2008 with the latest service packs. Note that Sage CRM does not support binary or case-sensitive collation, so the SQL server must be set up with case-insensitive collation.
- Microsoft Internet Information Server (IIS) 6.0 or 7.0 with the latest patches.
Sage 300 ERP

Refer to your Sage 300 ERP documentation for a complete list of Sage 300 ERP system requirements. For Sage 300 ERP integration with Sage CRM, you must install the following components on a server:

- Compatible database software. For details, refer to the Sage 300 ERP Installation and Administration Guide.
- Sage 300 ERP 2012 with the following programs:
  - System Manager
  - General Ledger
  - Accounts Receivable
  - Accounts Payable
  - Order Entry
  - Inventory Control

  **Note:** You must select the Portal option when installing Sage 300 ERP, and you must set up the Sage 300 ERP Portal as described in the Sage 300 ERP Installation and Administration Guide.

- Sage 300 ERP Web Deployment. Note that "web deployment" does **not** refer to setting up the Sage 300 ERP Portal, but instead refers to the process of deploying Sage 300 ERP on a web server to support remote Web Client access.

  For instructions on web deployment, see the Sage 300 ERP Installation and Administration Guide and the "Selecting Integration Settings" section in Chapter 6 of this guide.

**Notes:**

- Before integrating Sage CRM with Sage 300 ERP 2012, you must install the latest System Manager and application product updates.
- All Sage 300 ERP programs that you integrate with Sage CRM must be from Sage 300 ERP version 2012.
- If you have installed Sage CRM and Sage 300 ERP on separate servers, see "Setting Up the Sage CRM Rewriter and Virtual Directories" in Chapter 4 for information about changes to settings for integrating Sage CRM 7.1 with Sage 300 ERP 2012 on separate servers.
Sage CRM also integrates with the following Sage 300 ERP 2012 programs:
- Purchase Orders
- Return Material Authorization
- Project and Job Costing

Sage CRM also integrates with optional fields if you use Sage 300 ERP Transaction Analysis and Optional Field Creator.

**LanPak Licenses**

You do **not** need a Sage 300 ERP LanPak license to view and use the Sage 300 ERP integrated features that appear on Sage CRM screens. For example, you can:

- View opportunity status details and current totals (Quote Amount, Pending Amount, Order Amount, Shipment Amount, and Invoice Amount) on the Opportunity Summary screen.
- Create a new quote or order from the Company Summary screen.
- Use the Quotes screen to create new quotes, promote quotes to orders, or view a summary of quotes for an opportunity.
- Use the Orders screen to create new orders or view a summary of orders for an opportunity.
- Use the Sage 300 ERP Inquiry screens described in the "Using Sage 300 ERP Inquiry Features" section of this chapter, such as P/O Inquiry and R/A Inquiry.

You **do** need a LanPak license to use any Sage CRM feature that opens a Sage 300 ERP form. For example, the A/R Inquiry and O/E Inquiry screens include buttons and links that open Sage 300 ERP forms.

If you are upgrading to Sage CRM 7.1, make sure that you install enough LanPak licenses to support Sage CRM access to Sage 300 ERP forms.

**Client Workstations**

To set up a workstation that allows Sage CRM users to open Sage 300 ERP forms, you must either install Sage 300 ERP on that workstation or set up access to the Sage 300 ERP Web Client.

**Note:** The Web Client is **not** the Sage 300 ERP Portal. It is software that enables remote access to Sage 300 ERP deployed on a web server.
After setting up Web Client access, you must run Sage 300 ERP at least once per workstation before starting to work with Sage CRM.

The first time you use a browser to connect to a Sage 300 ERP company database, you will be prompted to download Web Client Setup files.

For more information, refer to your Sage 300 ERP documentation.

In addition to the requirements listed in Chapter 3 of the Sage CRM System Administrator Guide, workstations must meet the following minimum requirements for integration with Sage 300 ERP:

- **Windows XP or newer**. If you are using Windows Vista or Windows 7 on the client workstation or Windows 2008 on the server and you need to open Sage 300 ERP forms from Sage CRM, you must run Internet Explorer as an administrator. For instructions, refer to the section “Running Internet Explorer as an Administrator” in Chapter 4.

- **Microsoft Internet Explorer 8.0 or newer**. Note that you must apply the following security settings:
  - Download signed ActiveX controls
  - Run ActiveX controls and plugins
  - Script ActiveX controls marked as safe
  - Active scripting

**Now You Can...**

- Explain Sage CRM licensing requirements.
- List system requirements for the Sage CRM server, Sage 300 ERP server, and Sage 300 ERP workstations.
Chapter 3
Sage CRM Installation

In this chapter, you will learn:

- How to install Sage CRM.
- How to install Sage 300 ERP Accounting Integration for Sage CRM.

Sage 300 ERP Accounting Integration for Sage CRM adds components to Sage CRM so it can integrate with Sage 300 ERP accounting programs.

In addition to the installation described in this chapter, you must install integration components for Sage 300 ERP, so it can integrate with Sage CRM. For more information, see Chapter 5.

You must also configure servers and service access permissions as described in Chapter 4.

Installing Sage CRM

This section describes the procedure for a new installation of Sage CRM.

*If you are upgrading from a previous version of Sage CRM, or from a previous version of Sage 300 ERP,* refer instead to the *Sage CRM Integration Upgrade Guide* that is provided with your update package.

The instructions that follow are for Sage CRM 7.1 integrated with Sage 300 ERP 2012, where the installation is from the Sage 300 ERP 2012 DVD. *If you are installing Sage CRM 7.1 integrated with Sage 300 ERP 2012 from a Sage CRM DVD,* alternate instructions are noted in the procedure.

You should also refer to the instructions in Chapter 5 of the *Sage CRM System Administrator Guide*.

To install Sage CRM:

1. Insert the installation DVD.

2. Select software to install, and then click *Next*.

   - If you are installing from a Sage CRM 7.1 DVD, double-click *setup.exe* (if the installation program does not open automatically), and then select *Install Sage CRM.*
3. In the License Agreement dialog box, review the License Agreement carefully.
   - If you accept all of the terms, select **I accept the terms of the license agreement** and then click Next to continue.
   - If you do not accept the terms, click Cancel to end the installation.

4. In the User Details dialog box, type your name, company name, and license key. Your company name and license key must match the information provided to you by Sage, with identical capitalization, spacing, and punctuation.

5. Click Next.

6. Select your database type (the default selection is **Existing Microsoft SQL Server**), and then click Next.

   **Note:** If Sage CRM does not find the required Microsoft SQL Server or Client Tools installed, a dialog box appears that prompts you to install Microsoft SQL Server Express. You can install it or click Next to proceed.

7. Click Next.

8. In the Installation Name dialog box, type a name for the installation. We recommend that you use the default installation name CRM.

9. Click Next.

10. In the Choose Destination Location dialog box, specify the location for the Web Root Files. This becomes the default location for the Sage CRM program files.

    **Note:** We recommend that you use the default location \Program Files\Sage\CRM. IIS searches for the Sage CRM home page in this location.

11. Click Next.

12. In the SQL Database Server Login dialog box, confirm your server name and user ID, and enter the password for this user ID.

13. Click Next.

14. In the Select Setup Type dialog box, select the **No demo data** check box, and then click Next.
Depending on your license options, the Select Install Add Ons dialog box may appear.

15. If you want to install a sample site, select **Sample Self Service support site**, and then click **Next**.

16. In the Default Currency dialog box, select a currency, and then click **Next**.

**Note:** You can change your currency selection later when you reset the base currency in Sage CRM after performing the Synch Drop downs administration task described in Chapter 6: “Using Sage CRM for Sage 300 ERP.”

17. Review your settings, and then click **Next**.

Sage CRM installation begins.

**Note:** If you do not have the Java Runtime Engine installed, it is installed during the Sage CRM installation.

When the Sage CRM installation is complete, the Setup Complete dialog box appears, giving you an option to launch Sage CRM and a Release Notes file.

18. To complete the installation, click **Finish**.

Depending on what you selected, the Release Notes may appear in one browser window, and the Sage CRM logon page may appear in another browser window.

The next step in integrating Sage CRM and Sage 300 ERP is installing Sage 300 ERP Accounting Integration for Sage CRM. The process for doing this is described in the next section.

**Installing Sage 300 ERP Accounting Integration for Sage CRM**

After installing Sage CRM, you must install Sage 300 ERP Accounting Integration for Sage CRM.

**Note:** The version of the Sage 300 ERP Integration must match the version of Sage CRM that you are running. For example, you cannot add Sage 300 ERP Accounting Integration for Sage CRM 7.1 to a previous version of Sage CRM.
The instructions that follow are for Sage CRM 7.1 integrated with Sage 300 ERP 2012, where the installation is from the Sage 300 ERP 2012 DVD. If you are installing Sage CRM 7.1 integrated with Sage 300 ERP 2012 from a Sage CRM 7.1 DVD, alternate instructions are noted in the procedure.

**Note:** Sage CRM 7.1 does not integrate with Sage 300 ERP version 5.6 or earlier.

### To install Sage 300 ERP Accounting Integration for Sage CRM:

1. Insert the installation DVD.
2. Select software to install, and then click **Next**.
   - If you are installing from a Sage CRM 7.1 DVD, select **Install Sage 300 ERP Accounting Integration**, and then select **Install Integration Component for Sage CRM**.
   - If you are installing Sage CRM 7.1 from a Sage 300 ERP 2012 DVD, select **Sage CRM for Sage 300 ERP**, and then select **Sage 300 ERP Accounting Integration for Sage CRM**.
   The Integration Component for Sage CRM 7.1 dialog box appears.
3. Click **Next**.
4. Select a Sage CRM install to integrate with Sage 300 ERP, and then click **Next**.
5. Select an installation or upgrade option.
   - If you did not previously have Sage CRM integrated with Sage 300 ERP, select **Install Sage 300 ERP Integration**.
   - If you previously had Sage CRM integrated with Sage 300 ERP, and you have upgraded Sage CRM or Sage 300 ERP, select **Upgrade your existing Sage 300 ERP Integration**. For detailed instructions about upgrading the integration, see the Sage CRM 7.1 Integration Upgrade Guide.
6. Click **Next**.
7. Select a Sage 300 ERP version or upgrade path.
   - If you selected **Install Sage 300 ERP Integration** in the previous step, select Sage 300 ERP version 2012.
   - If you selected **Upgrade your existing Sage 300 ERP Integration** in the previous step, select the appropriate upgrade path. For detailed instructions, see the Sage CRM 7.1 Integration Upgrade Guide.
8. Click **Next**.

9. In the SQL Database Server Login details dialog box, confirm your server name and your SQL Server user ID, and enter the password for this user ID.

10. Click **Next**.

    The Sage 300 ERP Integration installation begins.

11. If you are prompted to stop IIS, click **Yes**.

    **Note:** IIS restarts automatically near the end of the installation process.

    When the installation is complete, the Setup Complete dialog box appears.

12. To complete the installation process, click **Finish**.

    If you did not clear the **Launch Now** check box, the Sage CRM logon page appears in a browser window.

If you are upgrading from a previous version, you may need to perform the following tasks after installing the upgrade:

- Reset IIS settings. For details, see Chapter 4.
- Re-synchronize tables. For details, see “Synchronizing Tables” in Chapter 5.

After installing Sage CRM and Sage 300 ERP Accounting Integration for Sage CRM, the next steps in integrating Sage CRM and Sage 300 ERP are:

- Configuring servers and server access permissions. For details, see chapter 4.
- Installing and activating the Sage 300 ERP integration component. For details, see chapter 5.

**Now You Can...**

- Install Sage CRM.
- Install Sage 300 ERP Accounting Integration for Sage CRM.
In this chapter you will learn:

- How server resources are accessed through a browser.
- How to work with Microsoft Internet Information Services (IIS).
- How to configure servers and server access if Sage CRM and Sage 300 ERP are installed on a single server.
- How to configure servers and server access if Sage CRM and Sage 300 ERP are installed on different servers.

### Accessing Server Resources through a Browser

**Using the Internet Guest Account**

When you access resources on a server through a browser, you do not access these resources through the user account you used to log on to the computer. By default, you access resources on the server as the default user created when you installed Internet Information Services (IIS). This account is called the Internet Guest Account.

The short name of this account is IUSR_Computer Name. For example, if the machine name of your computer is SERVERA, the Internet Guest Account user account that is automatically created by IIS would be IUSR_SERVERA.

To enable integration between Sage CRM and Sage 300 ERP, you must authorize the Internet Guest Account to access resources on the server.

These permissions/rights are a combination of directory access rights (for the NTFS file system) and setting rights to the server’s registry.

### Working with Internet Information Services Manager

This section is an overview of how to work with Microsoft Internet Information Services (IIS) Manager. For information on installing IIS, refer to the Sage 300 ERP Installation and Administration Guide.
Unless otherwise specified, instructions and figures in this section are based on Windows 2003 R2. See also the section, “Requirements for IIS 6.0 on Windows 2003 R2,” later in this chapter.

For more in-depth information, refer to the Internet Services Manager’s online help.

**Note:** Log on with Administrator rights to the server where Sage CRM is installed.

**To start the Internet Services Manager:**

- On the Windows taskbar, click **Start > Settings > Control Panel > Administrative Tools > Internet Information Services Manager.**

**Restarting IIS to Reflect Security Changes**

Whenever you change security settings on the server, you need to restart IIS to apply your changes.

**To stop and restart IIS:**

1. In Internet Information Services Manager, right-click the server name, and then select **All Tasks > Restart IIS.**

2. Click **Restart** to restart IIS.

IIS applies any security changes you made to the system.

**Checking the IIS Anonymous Access Account**

The IIS Anonymous Access account is the user account used by IIS to access resources on the server. The IIS Anonymous Access account can
be set either at the Default Website properties level or individually for each website that is running within IIS.

**To check the settings for the Sage CRM installation:**

1. In Internet Information Services Manager, double-click the server name to expand the tree view.
2. Click **Default Website**.
3. Right-click the Sage CRM installation, and then select **Properties**.
4. Click the **Directory Security** tab:

![Directory Security Tab](image)

5. In the Anonymous Access and Authentication Control section, click **Edit**.

The Authentication Methods form appears:

![Authentication Methods Form](image)
The **User name** field displays the name of the account with which IIS will log onto the server on this form. By default, this is the default Internet Guest Account created by IIS during installation.

6. Make sure the **Enable Anonymous Access** option is selected.

7. Click **OK** to save any changes you made, or click **Cancel** to exit without saving your changes.

8. If you made changes, restart IIS to apply them.

The following sections in this chapter describe security permissions that must be assigned to the Internet Guest Account.

---

**Note:** Before you assign security permissions to the Internet Guest Account, consider the following points.

- The preceding section describes how to view website settings for the Sage CRM website. You can also view the Default website properties by selecting the Default Website node under the computer name. From the shortcut menu, select Properties to display the default settings for all websites. These defaults can, however, be overwritten at the individual website level.

- If you prefer, you can create a separate account from the default Internet Guest Account created by IIS for use by the Sage CRM website. This may be preferable if you are running more than one website on this server.

---

**To create an account for the Sage CRM website:**

1. In Computer Management / Local Users and Groups, create a new user, such as CRM. This user must have the following rights:

   - Administrative rights on the Sage CRM server, as described in the sections “Setting Up Sage CRM and Sage 300 ERP on a Single Server” and “Setting up Sage CRM and Sage 300 ERP on Separate Servers”

   - Rights to the Sage CRM installation and data

   - Rights to Sage 300 ERP installation and data

   - Rights to read the registry on the Sage CRM server. If you need to access resources across a network (for example, if your database is on a different server), this would be a domain user.

2. On the Anonymous User Account setup form, click **Browse** and then select the new user you created.

   If you change the password for this account, you will also need to change it on the Anonymous User Account setup form.
Important: Make sure that you apply the security settings in the rest of this chapter to this new login account, and not to the default Internet Guest Account.

Requirements for IIS 6.0 on Windows 2003 R2

This section describes configuration requirements for Microsoft Internet Services Manager (IIS 6.0) on Windows 2003 R2. For more in-depth information, refer to the Internet Information Services Manager’s online help.

If you are configuring IIS 7.0 to work with Sage CRM, see the section “Running Sage CRM Integrated with Sage 300 ERP on Windows 2008” in this chapter.

Configuring IIS for Sage 300 ERP Integration

To set up IIS for Sage CRM, start by following the setup directions in the Sage CRM System Administrator Guide.

To set up IIS to work with Sage 300 ERP integration, you must open IIS Manager and perform further configuration to allow Active Server Pages and enable parent paths and buffering.

Note: Log on with Administrator rights to the server where Sage CRM is installed.

To open IIS Manager:

1. Log on with Administrator rights to the server where Sage CRM is installed.

2. On the Windows taskbar, click Start > Settings > Control Panel > Administrative Tools > Internet Information Services Manager.

In addition to allowing All Unknown ISAPI Extensions as described in the Sage CRM Technical Specification, you should also allow Active Server Pages in Web Service Extensions.

To allow Active Server Pages in Web Service Extensions:

1. Open IIS Manager.

2. Double-click the Sage CRM server.

3. Click the Web Service Extensions folder.
4. In the right pane, right-click **Active Server Pages**, and then click **Allow**.

The Status for Active Server Pages changes to **Allowed**.

To enable parent paths and buffering:

1. Open IIS Manager.
2. Double-click the Sage CRM server.
3. Right-click the **Websites** folder, and then select **Properties**.
4. Click the **Home Directory** tab.
5. Click the **Configuration** button.
6. On the Application Configuration form, click the **Options** tab.
7. Select the following options:
• Enable buffering
• Enable parent paths

8. Click OK to close the Application Configuration form.
9. Click OK to close the Properties form.
10. Restart IIS.

Setting Up Sage CRM and Sage 300 ERP on a Single Server

This section describes how to configure server access if you have installed Sage CRM and the Sage 300 ERP server on a single server. For instructions on how to configure server access if you have installed Sage CRM and the Sage 300 ERP server on separate servers, see the next section in this chapter, “Setting up Sage CRM and Sage 300 ERP on Separate Servers.”

Unless otherwise specified, the procedures and examples in this section are based on Windows 2003 R2.

The following is a summary of the steps for setting up Sage CRM and Sage 300 ERP on a single server after you install Sage 300 ERP and Sage CRM as described in Chapter 3.

To set up Sage CRM and Sage 300 ERP on a single server:

1. Configure access permissions for the IIS Anonymous Access Account (Internet Guest Account), as described in this chapter.
2. Install and set up the Sage 300 ERP Integration (E/W) Component. For details, see Chapter 5.
3. In Sage CRM, set up Sage 300 ERP integration, using the Sage 300 ERP Administration option on the Sage CRM Administration menu.

In the subsections to follow, you set specific rights for your IIS Anonymous User. It is recommended this user have administrative rights on the Sage CRM server.

**Setting Directory Access Rights for NTFS**

You must perform the tasks in this section if you are using the NTFS file system. If you are using a different file system (such as FAT32), proceed to the next section.

Sage CRM requires the following directory security rights to be set for the Internet Guest Account:

- Sage CRM installation directory requires full access.
- Sage 300 ERP Shared Data directory requires full access.

**To set security rights for the Sage CRM installation directory:**

1. In Windows Explorer, navigate to C:\Program Files\Sage\CRM\<CRMInstallName>.

   **Note:** This example assumes that Sage CRM is installed in C:\Program Files\Sage\CRM\<CRMInstallName>.

   If you specified another location during the Sage CRM installation, use it in place of \Sage\CRM.

2. Right-click the EWARE.CSS file, and then click **Properties**.

3. Click the **Security** tab.

4. Click the **Add** button.

5. Select the Internet Guest Account (IUSR_<ComputerName>).

6. Click **OK**.

   The Internet Guest User account is added to the list of user accounts that have rights to this directory.
Setting Up Sage CRM and Sage 300 ERP on a Single Server

7. Click **OK** to save the changes.

8. On the **Security** tab of the Properties form, select the Internet Guest Account.

9. Select the **Allow** option for the Full Control permission. (Full Control automatically selects all the other permissions, except Special Permissions.)

10. Click **OK**.

11. Repeat steps 1 to 10 to set Read and Write access for the `C:\Program Files\Sage\CRM\<CRMInstallName>` folder.

**Allowing Sage CRM to Connect to Sage 300 ERP Data**

To allow the Internet Guest Account to use the Sage 300 ERP Shared Data folder, you must add it to the user list, just as you added it for the Sage CRM program files directory.
To allow the Internet Guest account to access shared data:

1. In Windows Explorer, navigate to the Sage 300 ERP Shared Data folder. The default folder location is \Program Files\Sage Software\Sage 300 ERP).

2. Right-click the folder, and then click Properties.

3. In the Properties form, click the Add button.

4. Select the Internet Guest Account ("IUSR_<ComputerName>").

5. Click the Add button.

6. Click OK.


8. Select the Allow option for the Full Control permission.

9. Click OK.

The directory permissions are now set for Sage CRM.

You can now start Sage CRM, but you will not be able to access Sage 300 ERP information. Proceed to the next section to add the required registry rights to allow this.

Setting Registry Permissions for the Internet Guest Account

The Internet Guest Account must have permissions to access the registry to find the Sage 300 ERP program settings.
To set registry permissions for the Internet Guest Account:

1. On the Windows taskbar, click **Start > Run**.

2. Type `regedit`, and then click **OK**.

3. On the Registry Editor form, select `HKEY_LOCAL_MACHINE > HKEY_LOCAL_MACHINE\SOFTWARE`:

4. On the **Edit** menu, click **Permissions**.

The Permissions form appears:
5. Click the **Advanced** button.

6. Click **Add**.

7. Select the IUSR_<ComputerName> account.

8. Click **OK**.

9. Select the **Allow** option for the Full Control permission:

10. Click **OK**.

11. On the Advanced Security Settings form, click **Apply** to apply your changes:

12. Click **OK**.
Setting Path Statements

You need to ensure that path statements are set to allow Sage CRM to connect to Sage 300 ERP using the path to the Sage 300 ERP Runtime directory. (The default installation location is C:\Program Files\Sage\Sage 300 ERP\Runtime).

Note: If you are installing Sage CRM and Sage 300 ERP on separate servers, do not perform this step until you have installed Sage 300 ERP using the Sage 300 ERP Workstation Setup installation on the Sage CRM machine.

For details, see the section “Setting up Sage CRM and Sage 300 ERP ” in this chapter.

To set path statements:

1. On the Windows desktop, right-click My Computer, and then select Properties.
2. Click the Advanced tab.
3. Click Environment Variables:

   The Environment Variables form appears.

4. In the System Variables group, in the Variable column panel, click Path.
5. Click Edit.

Important: You must set the path statement in the System Variables group, not in the User Variables group.
Setting this path statement in the System Variables group sets the path for all users, including the Internet Guest Account.

The Edit System Variable form appears.

6. Append the Sage 300 ERP path C:\Program Files\Sage\Sage 300 ERP\Runtime to the end of the existing path statement.

**Note:** You must consider the following points before you proceed:
- Use a semicolon (“;”) to separate the new path from the existing path.
- The paths shown in this example are the default installation directories. If you installed Sage 300 ERP in a different directory, you will need to adjust the entries accordingly.

7. Click **OK** to save your changes to the Path variable.
8. Click **OK** to close the Environment Variables form.
9. Click **OK** to close the System Properties form.

We recommend that you restart your computer to ensure that all of the new settings are applied.

### Setting up Sage CRM and Sage 300 ERP on Separate Servers

This section explains how to configure server access if you have installed Sage CRM and Sage 300 ERP on separate servers. For instructions on how to configure server access if you have installed Sage CRM and Sage 300 ERP on a single server, see the previous section in this chapter, “Setting Up Sage CRM and Sage 300 ERP on a Single Server”.

The following is a summary of the steps for setting up Sage CRM and Sage 300 ERP on separate servers after you have installed Sage 300 ERP and Sage CRM.

**Note:** For two-server setup, we recommend that you use .NET web deployment to connect Sage CRM to Sage 300 ERP.
To set up Sage CRM and Sage 300 ERP on separate servers:

1. Install the Sage 300 ERP Integration (E/W) Component on the Sage 300 ERP server but do not set it up yet. For installation details, see Chapter 5, “Sage 300 ERP Integration (E/W) Component.”

2. Configure access permissions for the IIS Anonymous Access Account on the Sage CRM and Sage 300 ERP servers. See the next section, “Setting Up the IIS Anonymous Access Account.”

3. On the Sage CRM server:
   a. Install Sage 300 ERP Workstation.
   b. Set up the Sage 300 ERP Integration (E/W) Component.
   c. If you are using .NET web deployment, run Sage 300 ERP in a browser once on the Sage CRM server in order to download Sage 300 ERP .NET library components.

   For more information, see the section “Setting Up Sage 300 ERP Workstation and Integration on the Sage CRM Server” in this chapter.

4. In Sage CRM, set up Sage 300 ERP integration.

   Note: If you are using .NET web deployment, see “Selecting Integration Settings” in Chapter 6 of this guide for information about using .NET notation to specify your server name.

5. Set up the Rewriter to direct all SDataServlet requests to be handled by Tomcat on the ERP server, and create virtual directories or applications for the Sage CRM Rewriter and ERP static content. If you use IIS 6, you use the Sage CRM Rewriter; if you use IIS 7, you use the Microsoft Application Request Routing add-in for IIS. See the section “Error! Reference source not found.” in this chapter.

   Note: If you use IIS 7, you set up applications instead of virtual directories, as described in the procedures under “Error! Reference source not found.”.

Setting Up the IIS Anonymous Access Account

If you are setting up Sage CRM and Sage 300 ERP on separate servers, you must set the IIS Anonymous Access Account on the Sage CRM machine to a domain user account instead of a local machine user account. For instructions, refer to the section “Checking the IIS Anonymous Access Account” earlier in this chapter.
Instead of the default machinename\IUSR_machinename account, you must use a domain account, such as domainname\user1. This user must have the following rights:

- Rights to access Sage CRM and Sage 300 ERP programs and data, as described earlier in “Setting Up Sage CRM and Sage 300 ERP on a Single Server”
- Administrative rights on Sage CRM and Sage 300 ERP servers

In addition, you must change the account under which the Sage CRM Application Pool runs to use the IIS Anonymous User Account.

**To set the Sage CRM Application Pool to use the IIS Anonymous User Account:**


2. Double-click the server name.


4. Right-click the CRM AppPool entry, and then click Stop.

5. Right-click the CRM AppPool entry, and then click Properties.


7. In the Application Pool Identity group, select the Configurable option.

8. In the User Name and Password fields, enter the name and password of the IIS Anonymous User.
9. Click **Apply**, and then click **OK**.

10. On the Application Pools list, right-click the CRM AppPool, and then click **Start**.

11. Restart IIS as described earlier in “Restarting IIS to Reflect Security Changes.”

After you set the Sage CRM Application Pool to use the IIS Anonymous User account, you must add this account to the IIS worker process group (IIS_WPG).

**To add the IIS Anonymous User to the IIS worker process group:**

1. On the Windows taskbar, click **Start** > **Programs** > **Administrative Tools** > **Computer Management**.

2. Select **System Tools** > **Local Users and Groups** > **Groups**.

3. Double-click **IIS_WPG**.

4. Click **Add**.

5. On the Select Users, Computers, or Groups form, enter the name of the user.

6. Click **OK**.

7. On the IIS_WPG Properties form, click **Apply**, and then click **OK**.

**Note:** After you add the IIS Anonymous User account to the IIS worker process group, ensure that the IIS_WPG group has sufficient rights on the CRM installation folder. The default location is C:\Program Files\Sage\CRM\CRMInstallname.
Setting Up Sage 300 ERP Workstation and Integration on the Sage CRM Server

For information to flow from Sage 300 ERP to Sage CRM, you must:

- Set up the Sage 300 ERP workstation on the Sage CRM server using Workstation Setup with UNC paths, as described in the *Sage 300 ERP Installation and Administration Guide*.

- Set up the Sage 300 ERP Integration (E/W) Component, first on the Sage CRM server and then on the ERP server, as described in Chapter 5.

- Enable ASP.NET.

- Edit the JavaScript file Accpac_Session.js to set the default value for TWOSERVERSETUP to 1.

- Create and set up SDataServlet and Sage300ERP virtual directories (if you use IIS6) or applications (if you use IIS7).

- Set up the Rewriter on the Sage CRM server so it directs all SDataServlet and Sage300ERP requests to be handled by Tomcat on the Sage 300 ERP server. If you use IIS 6, you use the Sage CRM Rewriter; if you use IIS 7, you use the Microsoft Application Request Routing add-in for IIS.

- If you use IIS 7, install and set up Microsoft Application Request Routing and IIS URL Rewrite.

When you run the E/W Workstation Setup utility on the Sage CRM server, you will be prompted to install the Sage CRM Synchronization Component if it has not been installed. You must install this component to create the Web Services connection between Sage 300 ERP and Sage CRM.

**Note:** If you are using .NET web deployment, you must also run Sage 300 ERP in a browser once on the Sage CRM server in order to download Sage 300 ERP .NET library components

For instructions on how to install the integration component and create the Web Services connection, see Chapter 5.

To perform the setup procedures in this section, you will need the following information:

- The name and location of your Sage CRM installation
- The name or IP address of the Sage 300 ERP server
Enabling ASP.NET

In IIS, you must make sure that ASP.NET v2.0.50727 is enabled.

To enable ASP.NET v2.0.50727:
1. In IIS, in the left pane under the server name, select the Web Services Extensions folder.
2. In the right pane, select ASP.NET v2.0.50727.
3. Click Allow.

Editing Accpac_Session.js

In the JavaScript file Accpac_Session.js, the default value for TWOSERVERSETUP is 0. To integrate Sage CRM and Sage 300 ERP on separate servers, you must set this value to 1.

To edit Accpac_Session.js:
1. In Windows Explorer, navigate to \CRM install location\WWWRoot\CustomPages\Sage300ERP.
   For example, if you installed Sage CRM in Program Files\Sage, the install location would be as follows:
   C:\Program Files\Sage\CRM\WWRoot\CustomPages\Sage300ERP
2. Open Accpac_Session.js with the text editing software you prefer.
3. Find the TWOSERVERSETUP line, which should look like this:
   TWOSERVERSETUP = 0;
4. Edit the line as follows to set its value to 1:
   TWOSERVERSETUP = 1;
5. Save and close the file.

Creating and setting up IIS 6 Virtual Directories for the Sage CRM Rewriter

If you use IIS 6, you must create SDataServlet and Sage300ERP virtual directories on the Sage CRM server for the Sage CRM Rewriter.
Note: If you use IIS 7, you create applications instead of virtual directories, and you use Microsoft Application Request Routing. For instructions on creating and setting up applications, see "Setting Up the Sage CRM Rewriter for IIS 6"

To set up the Sage CRM Rewriter on the Sage CRM server so it directs all SDataServlet and Sage300ERP requests to be handled by Tomcat on the Sage 300 ERP server, you must add the name or IP address of the Sage 300 ERP server to the CRM.Rewriter file.

To set up the Sage CRM Rewriter on the Sage CRM server:

1. In Windows Explorer, navigate to the Sage CRM installation, and then open CRM > Services > IISUtils > CRMRewriter.
2. Open the file CRMRewriter in text editing software.
3. Add the following lines to the file, replacing <Sage 300 ERP server> with the name or IP address of the Sage 300 ERP server:
   
   ```
   RewriteRule ^/SDataServlet/(.*)$ http://<Sage 300 ERP server>/SDataServlet/$1?%{QUERY_STRING} [P]
   RewriteRule ^/Sage300ERP/(.*)$ http://<Sage 300 ERP server>/Sage300ERP/$1?%{QUERY_STRING} [P]
   ```
4. Save and close the file.
5. Exit IIS Manager.
6. Restart IIS.

Creating and Setting Up IIS 7 Applications for the Sage CRM Rewriter” in this chapter.

To create the SDataServlet virtual directory for the Sage CRM Rewriter on the Sage CRM Server:

1. Open IIS manager.
2. Right-click Default Web Site and select New > Virtual Directory.
   The Virtual Directory Creation Wizard appears.
3. Click Next.
4. In the Alias field, type SDataServlet.
5. Click Next.
6. On the Web Site Content Directory form, click **Browse**.

7. Navigate to `<CRM_HOME>\Services\IISUtils\CRM Rewriter`, and then click **OK**.

8. Click **Next**.

9. On the Access Permissions form, select the **Execute** option, and then click **Next**.

10. Click **Finish** to create the virtual directory.

11. Right-click the **SDataServlet** icon, and then click **Properties**.

12. On the **Virtual Directory** tab, select the **Directory Browsing** option.

13. On the **Application Pool** list, ensure that the **CRM Rewriter AppPool** option is selected.

14. Click the **Configuration** button.

15. On the **Mapping** tab, click the **Insert** button next to the **Wildcard application maps** field.

16. On the Add/Edit Application Extension Mapping form, click **Browse**.

17. Navigate to `C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727`, and then select `aspnet_isapi.dll`.

18. Verify that the **Verify that file exists** option is **not** selected.

19. Click **OK**.

20. Click **Apply**, and then click **OK**.

**To create the Sage300ERP virtual directory for the Sage CRM Rewriter on the Sage CRM Server:**

1. In IIS Manager, right-click **Default Web Site** and select **New > Virtual Directory**.

   The Virtual Directory Creation Wizard appears.

2. Click **Next**.

3. In the **Alias** field, type **Sage300ERP**, and then click **Next**.

4. On the Web Site Content Directory form, click **Browse**.

5. Navigate to `<CRM_HOME>\Services\IISUtils\CRM Rewriter`, and then click **OK**.

6. Click **Next**.
7. On the Access Permissions form, select the **Execute** option, and then click **Next**.

8. Click **Finish** to create the virtual directory.

9. Right-click the **Sage300ERP** directory, and then click **Properties**.

10. On the **Virtual Directory** tab, select the **Directory Browsing** option.

11. On the **Application Pool** list, ensure that the **CRM Rewriter AppPool** option is selected.

12. Click the **Configuration** button.

13. On the **Mapping** tab, click the **Insert** button next to the Wildcard application maps field.

14. On the Add/Edit Application Extension Mapping form, click **Browse**.

15. Navigate to `C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727`, and then select `aspnet_isapi.dll`.

16. Verify that the **Verify that file exists** option is **not** selected.

17. Click **OK**.

18. Click **Apply**, and then click **OK**.

### Setting Up the Sage CRM Rewriter for IIS 6

To set up the Sage CRM Rewriter on the Sage CRM server so it directs all SDataServlet and Sage300ERP requests to be handled by Tomcat on the Sage 300 ERP server, you must add the name or IP address of the Sage 300 ERP server to the CRM.Rewriter file.

**To set up the Sage CRM Rewriter on the Sage CRM server:**

7. In Windows Explorer, navigate to the Sage CRM installation, and then open `CRM > Services > IISUtils > CRMRewriter`.

8. Open the file `CRM.Rewriter` in text editing software.

**Note:** Depending on your settings, this file may be named `CRM.Rewriter.Rules`.

9. Add the following lines to the file, replacing `<Sage 300 ERP server>` with the name or IP address of the Sage 300 ERP server:

```plaintext
RewriteRule ^/SDataServlet/(.*)$ http://<Sage 300 ERP server>/SDataServlet/$1?%{QUERY_STRING} [P]
RewriteRule ^/Sage300ERP/(.*)$ http://<Sage 300 ERP server>/Sage300ERP/$1?%{QUERY_STRING} [P]
```

---

4–22    Sage CRM 7.1 for Sage 300 ERP
10. Save and close the file.

11. Exit IIS Manager.

12. Restart IIS.

**Creating and Setting Up IIS 7 Applications for the Sage CRM Rewriter**

If you use IIS 7, you must create and set up SdataServlet and Sage300ERP applications on the Sage CRM server for the Microsoft Application Request Routing IIS add-in.

*Note:* If you use IIS 6, you create virtual directories instead of applications. For instructions on creating and setting up virtual directories, see “Creating and setting up IIS 6 Virtual Directories” in this chapter.

**To create the SdataServlet application on the Sage CRM Server:**

1. Open IIS Manager.
2. Right-click **Default Web Site** and select **Add Application**.
   The Add Application form appears.
3. Leave the default value in the **Application Pool** field.
4. In the **Alias** field, type **SDataServlet**.
5. In the **Physical path** field, type **C:\**.
6. Click **OK** to create the application.

**To create the Sage300ERP application on the Sage CRM server:**

1. In IIS Manager, right-click **Default Web Site** and select **Add Application**.
   The Add Application form appears.
2. Leave the default value in the **Application Pool** field.
3. In the **Alias** field, type **Sage300ERP**.
4. In the **Physical path** field, type **C:\**.
5. Click **OK** to create the application.
6. Close IIS Manager.
Installing Microsoft Application Request Routing v2.5 and setting up IIS URL Rewrite for IIS 7

To integrate Sage CRM and Sage 300 ERP on separate servers with IIS7, you must install and set up Microsoft Application Request Routing, and set up IIS URL Rewrite.

To install Microsoft Application Request Routing:
2. Follow the instructions on the site to download and install Application Request Routing (ARR) 2.5.

During installation, IIS URL Rewrite is also installed.

After installation is complete, you must enable proxy settings for Application Request Routing.

To enable proxy settings for Application Request Routing:
1. Open IIS Manager.
2. In the left pane, select the server node.
3. In the right pane, double-click Application Request Routing.
4. In the Actions pane on the right of the screen, click Server Proxy Settings.
5. Select the Enable Proxy option, leaving default values for all other options.
6. Click Apply.

To set up URL Rewrite:
1. In IIS Manager, select Default Web Site.
2. Double-click URL Rewrite.
3. In the Actions pane, click Add Rule(s).
4. In the Inbound Rules group, select Blank rule, and then click OK to open the Edit Inbound Rules screen.
5. In the Match URL group:
   a. In the Name field, type Sage300ERP.
   b. Select the Matches the Pattern option for the Requested URL.
   c. On the Using list, select the Regular Expressions option.
d. In the **Pattern** field, type `^Sage300ERP/(.*)$`.  

   e. Select the **Ignore Case** option.

6. In the **Action** group:

   a. For **Action Type**, select **Rewrite**.

   b. In the **Rewrite URL** field, type `http://<Sage 300 ERP Server>/Sage300ERP/{R:1}`, replacing `<Sage 300 ERP Server>` with the name or IP address of the Sage 300 ERP server.

   c. Select the **Append query string** option.

   d. Clear the **Log rewritten URL** option.

   e. Select the **Stop processing of subsequent rules** option.

   f. Click **Apply**.

7. Click **Back to Rules**.

8. Click **Add Rule(s)**.

9. In the **Inbound Rules** group, select **Blank rule**.

10. Click **OK** to open the Edit Inbound Rules screen.

11. In the **Match URL** group:

   a. In the Name field, type `SDataServlet`.

   b. Select the **Matches the Pattern** option for the **Requested URL**.

   c. On the **Using** list, select the **Regular Expressions** option.

   d. In the **Pattern** field, type `^SDataServlet/(.*)$`.

   e. Select the **Ignore Case** option.

12. In the **Action** group:

   a. For **Action Type**, select **Rewrite**.

   b. In the Rewrite URL field, type `http://<Sage 300 ERP Server>/SDataServlet/{R:1}`, replacing `<Sage 300 ERP Server>` with the name or IP address of the Sage 300 ERP server.

   c. Select the **Append query string** option.

   d. Clear the **Log rewritten URL** option.
e. Select the **Stop processing of subsequent rules** option.

f. Click **Apply**.

13. Exit IIS Manager.

14. Restart IIS.

**Other Settings**

- If you are using .NET to connect Sage CRM to Sage 300 ERP, you will need to add the Sage 300 ERP web components to the Sage CRM server.

To do so, you must:

- Run Sage 300 ERP Web Deployment using .NET remoting. See the *Sage 300 ERP Installation and Administration Guide* for details.

- Run Sage 300 ERP in browser mode (as a web client) on the Sage CRM server, up to signing on to your company. This will add the Sage 300 ERP .NET components to the Sage CRM server.

- If you are using .NET web deployment in Sage 300 ERP (described in the *Sage 300 ERP Installation and Administration Guide*), you must run it under an account that has sufficient rights on the Sage 300 ERP and Sage CRM servers (for example, a domain user account).

**To select an account for .NET web deployment:**

1. On the Windows taskbar, click **Start > Programs > Administrative Tools > Services.**

2. On the list of services, double-click **Sage 300 ERP .NET Remoting Service.**

3. Click the **Log On** tab.

4. Select a user account with sufficient rights on the Sage 300 ERP and Sage CRM servers.

5. Click **OK.**
Running Sage CRM Integrated with Sage 300 ERP on Windows 2008 Server

This section describes additional requirements for running Sage CRM integrated with Sage 300 ERP on a Windows 2008 server, and addresses issues you may encounter when using this setup.

**Note:** Unless otherwise indicated, the settings described in the previous sections on configuring servers and server access permissions also apply to Windows 2008.

If you are running Sage CRM integrated with Sage 300 ERP on a Windows 2008 server, you need to perform the following tasks:

- Set up IIS Role Services and Parent Paths.
- Set the IIS 7 Impersonated User.
- Set IIS Feature Permissions to Execute.
- Run Internet Explorer as an administrator.
- Use regacc to register Sage 300 ERP screens.

If you need to run Sage CRM and open integrated Sage 300 ERP screens on a Windows 2008 server while logged in to Windows as a user who is not the local administrator, additional steps are described below in the section “Sunning Sage CRM on Windows 2008 as a Non-Administrative User.”

**Setting Up IIS Role Services and Parent Paths**

After you install IIS as a Server Role, make sure the following Role Services are added to the Sage CRM server, in addition to any described in the *Sage CRM Technical Specification* or *System Administrator Guide*:

- Windows Authentication
- Management Console
- IIS Management Compatibility
- Application Development (to make sure ASP and ISAPI Extensions are installed)

**To add IIS Role Services:**

1. On the Windows taskbar, click **Start > Administrative Tools > Server Manager**.
2. In the Roles Summary or Features Summary areas of the Server Manager main form, click **Add Roles**.

3. Right-click **Web Server (IIS)**, and then select **Add Role Services**.

4. In the list that appears, select the following options:
   - Windows Authentication
   - Management Console
   - IIS Management Compatibility
   - Application Development

5. Save your changes and exit Server Manager.

6. Restart IIS.

After adding Role Services, you must check to ensure that parent paths are enabled.

**To enable IIS Parent Paths:**

1. In Server Manager, select **IIS > Web Server (IIS) > Internet Information Server (IIS) Manager**.

2. On the **Connections** list, select your current server name.

3. On the list of features that appears at the right, right-click ASP, and then click **Open Feature**.

4. In the form that appears, set **Enable Parent Paths** to **True**.

5. Click **Apply**.

6. Save your changes and exit Server Manager.

7. Restart IIS.

**Setting the IIS 7 Impersonated User**

To run Sage CRM integrated with Sage 300 ERP on a Windows 2008 server, you must set the IIS 7 Impersonated User.

**To set the IIS 7 Impersonated User:**

1. Open IIS.

2. In the left pane, select your server, and then select **Web Sites > Default Web Site**.

3. Right-click the **Sage CRM** site, and then select **Manage Application > Advanced Settings**.
4. On the Advanced Settings form, click the browse (“…”) button beside the **Physical Path Credentials** field.

5. Select **Specific User**.

6. Click Set.

7. Enter the name of the user that should be impersonated by Sage CRM.

8. Restart IIS.

### Setting IIS Feature Permissions to Execute

To run Sage CRM integrated with Sage 300 ERP on a Windows 2008 server, you must set IIS 7 Feature Permissions to Execute.

**To set Feature Permissions to Execute:**

1. In IIS, select the Sage CRM installation.

2. In the right panel, double-click **Handler Mappings**.

3. On the Handler Mappings form, click **Edit Feature Permissions**.

4. On the Edit Feature Permissions form, select **Execute** (if it is not already selected).

5. Restart the server.

### Running Internet Explorer as an Administrator

If you are running Sage CRM and Sage 300 ERP on separate Windows 2008 servers, you should run Sage 300 ERP Workstation Setup on the Sage CRM server while logged in as an administrator.

If you need to open Sage 300 ERP in a browser in order to download the .NET components, you should run Internet Explorer as an administrator.

**To run Internet Explorer as an administrator:**

1. On the Windows taskbar, click **Start > Programs**.

2. Right-click **Internet Explorer** and select **Run as Administrator**.

### Using Regacc to Register Sage 300 ERP Screens

You must run regacc to register the Sage 300 ERP screens on the Sage 300 ERP server, and also on the Sage CRM server (which has Sage 300 ERP Workstation Setup on it).

Before you start, check that you are logged in as the local administrator.
Running Sage CRM Integrated with Sage 300 ERP on Windows 2008 Server

To run regacc:

1. On the Windows taskbar, click **Start > Run**.
2. Type **regacc** and click **OK**.
3. The Register Sage 300 ERP Programs message appears.
You may need to repeat this task if you are logged in as a different user and the Sage 300 ERP desktop does not open properly.

Running .NET Remoting Service under the Local Administrator Account

If you are using .NET, you must run the Sage 300 ERP .NET remoting service under the local administrator account, even if you have used the Web Deployment Wizard to run Sage 300 ERP using a different account (for example, a domain account).

To run .NET remoting under the local administrator account:

1. On the Windows taskbar, click **Start > Programs > Administrative Tools > Services**.
2. Double-click **Sage 300 ERP .NET Remoting Service**.
3. On the Properties form, click **Stop** to stop the service.
4. Click the **Log On** tab.
5. Under **Log on as**, select **This account**.
6. Enter the name and password of the local administrator.
7. Click **OK** to save your settings.
8. To re-start the service, right-click **Sage 300 ERP .NET Remoting Service**, and then click **Start**.

Running Sage CRM on Windows 2008 Server as a Non-Administrative User

If you need to run Sage CRM on the Windows 2008 server while logged in to Windows as a user who is not the local administrator, and you wish to open the Sage 300 ERP screens from within Sage CRM on the server, you may need to do one or all of the following, depending on your security settings:

- Run Internet Explorer as an administrator (refer to the previous section “Running Internet Explorer as an Administrator”)
Now You Can…

- Set a4wSignonMgr to run as administrator
- Check that controls have not been disabled

**To set a4wSignonMgr to run as administrator:**
1. Navigate to the `\Sage 300 ERP\Runtime` folder.
2. Right-click `a4wSignonMgr.exe`.
3. Click the Compatibility tab.
4. Select the **Run as Administrator** option.
5. Click **OK**.
6. Restart the server.

If a control will not open, you can check to see if it has been disabled in Internet Explorer.

**To check for disabled controls:**
1. Open Internet Explorer.
2. On the **Tools** menu, click **Manage Add-Ons**.
3. If any “eCRM*.*” or “Sage 300 ERP (Accpac)*.*” control is marked as disabled, select the control and click the **Enable** button.
4. When you are finished, click **Close**.

**Notes:**
- For 64-bit installation, ensure that IIS is running both Sage CRM and Sage 300 ERP as 32-bit applications. For details, see the **Sage CRM System Administrator Guide** and the **Sage 300 ERP Installation and Administration Guide**.
- If you need to install Microsoft .NET Framework 1.1 as part of the Synchronization Component install, a Windows compatibility warning message may appear. If you see this message, disregard it and continue with the .NET installation. In addition, we recommend you install the latest service pack for .NET 1.1.

**Now You Can...**

- Explain how server resources are accessed through a browser.
- Explain how to work with IIS.
Now You Can...

- Configure server access on the Sage CRM and Sage 300 ERP servers if they are installed on the same server.
- Configure server access if you have installed Sage CRM and Sage 300 ERP on separate servers.
In this chapter you will learn how to install, activate, and set up the Sage 300 ERP Integration Component.

The Sage 300 ERP Integration Component, also known as the E/W component, must be installed with Sage 300 ERP so it can integrate with Sage CRM. The E/W component establishes a seamless link between your Sage 300 ERP accounting system and Sage CRM, allowing information to flow from Sage 300 ERP to Sage CRM, and from quotes or orders.

**Note:** The E/W integration component differs from the integration component for Sage CRM introduced in Chapter 3, which enables information to flow from Sage CRM to Sage 300 ERP.

### Overview of Steps

To install, activate, and set up the Sage 300 ERP integration (E/W) component, follow these steps. The rest of this chapter describes each step in more detail.

1. Install the E/W integration component on the server where Sage 300 ERP is installed, and also on any workstations that have Sage 300 ERP accounting programs installed.

2. Activate the E/W integration component.

   The following icons appear in the Sage CRM folder on the Sage 300 ERP company desktop:
   - Sage CRM Setup
   - Workstation Setup
   - Error Log

3. Open the Sage CRM Setup form and select integration and notification options for your system.

4. Run the Workstation Setup utility on any Sage 300 ERP desktop workstation (whether Sage 300 ERP programs are installed locally or running from the server) that you wish to integrate with Sage CRM.
You do not need to run the Workstation Setup utility on the client if you are running a browser client only.

After you select the appropriate options and complete these setup steps, any changes made to customers, customer ship-to addresses, vendors, vendor remit-to addresses, and quotes or orders linked to an opportunity in Sage 300 ERP are reflected automatically in Sage CRM.

**Installing the E/W Integration Component**

You install the E/W integration component for Sage CRM 7.1 as part of the Sage 300 ERP installation.

**To install the E/W integration component:**

- During installation of Sage 300 ERP, on the Select Features screen, select **Sage CRM Integration**.

  **Note:** After installing Sage 300 ERP, you must install the Web Services synchronization component on each client workstation where you use the E/W integration component. For more information, see “Setting Up Sage 300 ERP Workstations” later in this chapter.

Proceed to the next section to activate the Sage 300 ERP Integration Component within your Sage 300 ERP accounting system.

**Activating Sage CRM Integration within Sage 300 ERP**

After you install the Sage 300 ERP Integration (E/W) Component, you must activate it.

**To activate the E/W component:**

1. Open Sage 300 ERP.

2. Log on as the ADMIN user in your company database. If security is activated in Sage 300 ERP, you must enter the password for the ADMIN user.

3. Select **Administrative Services > Data Activation**.

4. On the **Applications for Activation** list, select the appropriate version of Sage CRM Integration, and then click **Activate**.

The Sage CRM Integration Activation form appears.
5. In the Sage CRM Installation Name field, enter the name of your Sage CRM installation.

6. Click **Proceed** to complete the activation.

   **Note:** To cancel the activation while it is in progress, click **Close** on the Activation form.

7. When activation is complete, close the Data Activation form.

The Sage CRM folder appears on the Sage 300 ERP desktop.

---

**Selecting Integration and Notification Options**

The Sage CRM Setup form lets you select several options for running Sage CRM with Sage 300 ERP. You must use this form to select setup options when you first set up Sage CRM.

Once you have set up Sage CRM Integration, use this form when you want to change your selections.

**To use the Sage CRM Setup form:**

1. In the Sage CRM folder, select **Sage CRM Setup**.

   The E/W Sage CRM Setup form appears.

2. Review and select the following connection options on the Setup form:

   - **Suspend All Integration to Sage CRM.** Select this option if you do *not* want any changes in Sage 300 ERP to be reflected automatically in Sage CRM.
   
   - **Suspend A/R Integration to Sage CRM.** Select this option if you do *not* want changes in Accounts Receivable to be reflected automatically in Sage CRM.

   - **Suspend A/P Integration to Sage CRM.** Select this option if you do *not* want changes in Accounts Payable to be reflected automatically in Sage CRM.

   - **Suspend O/E Integration to Sage CRM.** Select this option if you do *not* want changes in Order Entry to be reflected automatically in Sage CRM.

   **Note:** If you suspend O/E integration to Sage CRM, the totals and forecasting information on the Opportunity Summary, Quote Summary, and Order Summary screens will not be updated with information from Sage 300 ERP.
You may also see errors when saving quotes or orders in Sage CRM if O/E integration is suspended.

**Suspend A/R Ship-To Addresses Integration to Sage CRM** or **Suspend A/P Remit-To Addresses Integration to Sage CRM.** Select this option if you do not want changes to these addresses in Accounts Receivable or Accounts Payable to be reflected automatically in Sage CRM. (Note that after an installation, these two options are selected by default.)

**Suspend A/R National Account Integration to Sage CRM.** Select this option if you do not want changes to the National Account relationship in AR Customers to be reflected automatically in Sage CRM.

**Sage CRM Installation Name.** Ensure that the Sage CRM installation is correct (the default is CRM).

If you change this field, click the **Sage CRM Web Services URL** button to automatically update the Installation Name portion of the Web Services URL field.

**Logon User.** The default is "CRM". The CRM user account is created automatically within Sage CRM to allow Sage 300 ERP to connect to it. Accept this default user.

**Password.** To add security to this connection, enter a password.

**Note:** If you change the password for the Logon user, you also need to change the password for this user within Sage CRM.

**Sage CRM Server Name.** This should default to your computer’s machine name. If Sage CRM and Sage 300 ERP are installed on separate servers, enter the name of the Sage CRM server.

If you change this field, click the **Sage CRM Web Services URL** button to automatically update the Server Name portion of the Web Services URL field.

**Web Services URL.** The Web Services URL field consists of the Sage CRM Server Name field, the Sage CRM Installation Name field, and program defaults. For example: http://605DEV05/CRM09/eware.dll/webservices/soap where 605DEV05 is the server name, and CRM09 is the installation name.

If you make changes to the Sage CRM Server Name field or the Sage CRM Installation Name field, click the **Sage CRM Web Services URL** button to automatically update the corresponding portions of the URL field.
Alternatively, you can simply type over the existing value in the URL field. The server name and installation name used in the URL must be the same as the value in the Sage CRM Server Name field and the Sage CRM Installation Name field.

3. Review the notification options at the bottom of the Setup form.

**Acknowledge operations.** By default, whenever a customer or vendor record is edited and saved in Sage 300 ERP, a notification informs the user that the update to Sage CRM was successful. Uncheck this option if you do not want to receive notification messages.

**Display errors.** By default, the integration component alerts the user to any problems that occur when the program tries to update a customer or vendor in Sage CRM. You can turn this option off and view the error log to review any problems.

**Log errors.** This option allows the administrator to turn on or off the logging of errors received by the integration component.

4. Click Save to complete the setup process.

---

**Setting Up Sage 300 ERP Workstations**

You must run the Workstation Setup utility on any Sage 300 ERP desktop workstation that you want to integrate with Sage CRM, whether Sage 300 ERP programs are installed locally or running on the server. You do not need to run the Workstation Setup utility on the client if you are running a browser client only.

**To run workstation setup:**

1. Start Sage 300 ERP on the workstation you want to set up.

2. Select the Sage CRM folder, and then select **Workstation Setup**.

3. If the Sage CRM synchronization component has not yet been installed, a message appears.

   Click Yes to install the synchronization component, and then follow the instructions provided by the setup wizard.

4. A message informs you if the workstation is currently set up to communicate with Sage CRM.

   **Note:** This message appears even if the communication connection between Sage CRM and Sage 300 ERP is not successful. You can test the connection in a following step.

5. Click Close.
The E/W Sage CRM Workstation Setup form appears and displays the Web Services URL:

<table>
<thead>
<tr>
<th>Sage CRM Installation Name</th>
<th>CRM001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Server Name</td>
<td>EV02</td>
</tr>
<tr>
<td>Sage CRM Web Services URL</td>
<td><a href="http://SAGE02/CRM001/exware.dll/web_services/soap">http://SAGE02/CRM001/exware.dll/web_services/soap</a></td>
</tr>
</tbody>
</table>

6. To test the connection, click the **Test** button.
7. Click **Close** to exit.

**Note:** If you move Sage CRM to another installation location or to a different server, you must rerun the Sage CRM Setup program and the Sage CRM Workstation Setup utility.

### Now You Can...

- Install the E/W integration component.
- Activate Sage CRM integration within Sage 300 ERP.
- Select your integration and notification options.
- Set up Sage 300 ERP workstations.
In this chapter you will learn how to log on to Sage CRM, select integration settings, synchronize tables and currency, import accounts, convert existing Order Entry documents, and set up Sage 300 ERP security.

Logging On to Sage CRM

On the Sage CRM server, you can start Sage CRM from the Windows taskbar by clicking **Start > Programs > Sage CRM 200** (or **Sage CRM 100**).

On a client workstation, use the following procedure to start Sage CRM.

**To start Sage CRM:**

1. Open an Internet Explorer browser window.
2. In the address bar, enter the Sage CRM installation’s URL in the following format:

   http://<servername>/<crminstallation>

   For example, if your Sage CRM server name is Sage300ERP, and you installed Sage CRM with the default installation name of CRM, enter the following into your browser:

   http://Sage300ERP/CRM

   The **Log On** screen appears.

3. Enter **admin** in the User Name field, and leave the Password field blank.

4. Click the **Log On** button.

   Sage CRM displays the splash screen, or the My CRM work area.
Selecting Integration Settings

If this is a new installation, you must configure the connection to the Sage 300 ERP database by selecting integration settings.

To select integration settings:

1. On the left sidebar, click **Administration**.
2. On the Administration screen, click **Sage 300 ERP Administration**. The Sage 300 ERP Administration screen appears.
3. Click **Setup Integration**.
4. To add a link to a new database, click the **New** button in the right sidebar.
5. The Sage 300 ERP Integration Configuration screen appears:

   ![Sage 300 ERP Integration Configuration Screen]

6. Complete this form with the following information:
   - **Sage 300 ERP company database ID.** (For example, SAMLTD.)
   - **Sage 300 ERP Company name.** (For example, Sample Company Limited.)
   - **Sage 300 ERP Server Name.** Enter the name of the Sage 300 ERP server or computer. If you are using .NET web deployment, use .NET notation, in the form net://<machinename>:9000 (where 9000 is the port used by .NET remoting).

   **Note:** If you are installing Sage CRM and Sage 300 ERP on separate servers, we recommend that you use .NET web deployment to connect Sage CRM to Sage 300 ERP. We also recommend that you do **not** select the **Encryption** option when running the Sage 300 ERP Web Deployment Wizard.

   - **Default Company.** Select this option to set this as the default company. (You must select one company to be the default.)

7. Click **Save**.
8. If you are finished, click **Continue** to exit. If you want to add another company, repeat steps 3 to 6.
The Sage 300 ERP Administration screen appears. Because you have set up integration settings, the **Synchronize Tables** option is now available.

### Synchronizing Tables

The Synchronize Tables function updates Sage CRM database tables with the tables defined for the following fields in the Sage 300 ERP database:

- Groups
- Tax Groups
- Terms
- Salespersons
- Currencies

You must synchronize tables after the installation is completed and before you add any data to the system.

**To synchronize tables:**

1. On the Sage 300 ERP Administration screen, click **Synchronize Tables**.

   The Select Sage 300 ERP Integration Tables to Synchronize screen appears.

2. On the **Sage 300 ERP Company Name** list, select a company name.

3. Select each of the tables that you want to synchronize.

   **Note:** If the **Currency Upload** check box does not appear, and this is a new Sage CRM install (not an upgrade), and you need to import currency, please see the following section “Resetting Currency in New Installations”.

4. Click the **Synchronize** button.

   When synchronization is completed, Sage CRM displays the values extracted from the Sage 300 ERP database:
5. Click **Continue**.

6. Repeat for each company.

## Resetting Currency in New Installations

After you perform integration and synchronize tables, the base currency is removed and all currency exchange rates are set to 1. You must reset the base currency, and then set up currency rates against the base currency if you are using multicurrency.

**To reset base currency:**

1. On the left sidebar, click **Administration**.
2. Click **Data Management**.
3. Click **Currency Configuration**.
4. On the right sidebar, click **Change**
5. On the **Currency** tab, select options for **Base Currency** and **Is Single Currency**.

If you are using multicurrency, you must reset currency rates against the base currency.
To reset currency rates against base currency:
1. On the left sidebar, click Administration.
2. Click Data Management
3. Click Currency.
4. Click the name of a currency to edit the rate.

For more information on setting up currencies in Sage CRM, refer to the “Multicurrency Support” chapter in the Sage CRM System Administrator Guide.

Currency Troubleshooting

In exceptional circumstances, you may need to synchronize currencies manually.

For example, if you have an existing Sage CRM installation set up with currencies and you want to integrate it with Sage 300 ERP, the Currency Upload check box and Currencies button are not available because currencies are already set up.

**Important:** If you synchronize currencies, you delete all existing currency values, so any value in the database that contains a currency value is affected. After you synchronize, you must reset all currency rates against the base currency.

- To display the Currencies button in the Sage 300 ERP Administration screen, insert the parameter ManualCurrency, with a value of Y, into the Sage CRM database’s Custom_Sysparams table.
- To display the Currency Upload check box on the list of currencies to synchronize, insert the parameter CanImportCurrency, with a value of Y, into the Sage CRM database’s Custom_Sysparams table.

Importing Customer, Vendor, and National Account Relationships from Sage 300 ERP

The Import Customers and Import Vendors functions let you import a range of customers and vendors from Sage 300 ERP Accounts Receivable and Accounts Payable into Sage CRM.
To import customers, vendors and national accounts into Sage CRM:

1. On the Sage 300 ERP Administration screen, click Import Customers (or Import Vendors).

   The Import tab appears.

2. On the Sage 300 ERP Company Name list, select a company.

3. Select records to import.

   - If you are importing customers, you can select customer records, or ship-to address records, or both.
   - If you are importing vendors, you can select vendor records, or remit-to address records, or both.

   **Note:** If you import ship-to addresses or remit-to addresses, you must also import the associated customer or vendor records at the same time, unless the customer or vendor records have already been imported into Sage CRM.

   For example, if you had previously imported customers 1000 to 2000, you can select Import Ship-To Addresses for customers 1000 to 2000, without selecting Import Customers.

   You use these import options in conjunction with the From/To Customer Number (or From/To Vendor Number) fields — see the next step.

4. Specify the range of customers or vendors that you want to import, or leave the default values in the From and To fields to import all customers or vendors.

   - If you are importing customers, the range you specify is applied to both the Import Customers and Import Ship-To Addresses fields.
   - If you are importing vendors, the range you specify is applied to both the Import Vendors and Import Remit-To Addresses fields.

   **Note:** In step 4, if you selected only the Import Ship-To Addresses option for customers or only the Remit-To Addresses option for vendors, Sage CRM will import the addresses of the customers or vendors that fall within the specified range.

   For example, if you specified a customer range from 1000 to 2000, Sage CRM imports the ship-to addresses of customers 1000 to 2000.
5. Click the **Import from Sage 300 ERP** button.

   A list of 100 customers or vendors appears at a time while they are
   being imported.

   **Note:** If you are importing data from a large database for the first
   time may be lengthy.

   When the process is complete, Sage CRM displays the number of
   customers or vendors (and ship-to and remit-to addresses) imported,
   and the **Continue** button appears.

6. Click **Continue** to return to the Sage 300 ERP Administration screen.

7. Repeat steps 1 to 6 to export vendors.

If you want to import National Accounts information from Sage 300 ERP,
use the following procedure.

**To import national accounts:**

1. On the Sage 300 ERP Administration screen, click Import National
   Accounts.

2. Specify a range of accounts to import, and then click the **Import from
   Sage 300 ERP** button.

   Sage CRM imports the accounts and a confirmation screen appears.

3. Click **Continue** to exit.

4. Repeat steps 1 to 3 for each company.

**Converting Existing Sage 300 ERP O/E Quotes and Orders**

If you are upgrading to Sage CRM 7.1 integrated with Sage 300 ERP
version 2012 from Sage CRM integrated with Sage 300 ERP 5.6 or earlier,
you must convert existing Order Entry quotes and orders to make them
compatible with the new integration.

Sage CRM converts **only** existing quotes and orders that are linked to
Sage CRM opportunities.

After successful conversion, Sage CRM displays information from
converted documents in opportunity totals and forecast amounts on all
summary screens for an opportunity.
Converting Existing Sage 300 ERP O/E Quotes and Orders

**Note:** If you convert existing invoices or shipments that include miscellaneous charges, the amount of the miscellaneous charges is not reflected in opportunity totals and forecast amounts.

When you activate Sage 300 ERP 6.0 or 2012 (6.1) Order Entry, the following fields are added to the OERDH, SHID, and INVD tables:

- Company ID
- Opportunity ID
- Person

When you run conversion in Sage CRM, the program performs the following tasks:

- Searches for Order Entry documents with eCRM Ref#=x in the Reference field, clears the Reference field, and adds Opportunity ID, Company ID, and Person ID to the appropriate tables.
- Updates the Opportunity and Opportunity Items tables to support showing Opportunity Totals and Forecast amount.
- Sets all existing quotes to be included by default in the Opportunity Totals shown on the Opportunity Summary screen.

During conversion, any Sage CRM companies with quotes or orders for non-existent customers (customers not linked to Sage 300 ERP Accounts Receivable) will be linked to the Sage 300 ERP company database you select during conversion.

**Conditions for Successful Conversion**

To be converted successfully, documents must meet the following conditions:

- Opportunity Status must be In Progress
- Order Type must be Active or Quote
- All quotes used to create an order must belong to the same opportunity as the order
- An order that was created from one or more quotes must contain opportunity information in the Reference field

Before starting conversion, make sure the documents you need to convert meet the above conditions.
Important: If any document belonging to an opportunity fails to meet any of the above conditions, no documents that belong to that opportunity will be converted.

If you view an opportunity that could not be converted, you will not see any existing quotes or orders linked to that opportunity. The forecast and totals for the opportunity may also show incorrect information or a “Currency not set” message.

If you need to keep any documents that belong to an opportunity that could not be converted, you may need to remove and reenter the opportunity and all transactions associated with it.

To convert existing documents for Sage CRM integration:
1. Log on to Sage CRM.
2. On the left panel, click the Administration link.
3. On the Administration screen, click the Sage 300 ERP Administration icon.
4. On the Sage 300 ERP Administration tab, click the Convert OE Quotes and Orders icon.

   The Convert existing Sage 300 ERP O/E Quotes and Orders tab opens.
5. On the Sage 300 ERP Company Name list, select a company name.
6. Enter a range of customer numbers to convert. You can use the default values in the From Customer Number and To Customer Number fields to select all documents, or specify a limited range if you have a large number of documents to convert.
7. On the right panel, click Convert Sage 300 ERP O/E Data.

   Sage CRM begins converting the documents you selected.

After conversion, a conversion log lists opportunities that were successfully converted and opportunities that could not be converted, grouped by customer number. A copy of the log file is saved to the Sage 300 ERP COMPANY directory.

Notes:

- Unlike the conversion log that appears in Sage CRM after conversion, the saved log file does not group opportunities by customer number.

- If a miscellaneous charge has been added to a shipment or invoice for an order linked to an opportunity that is being converted, the
amount of the miscellaneous charge will not appear in the shipment or invoice totals.

## Setting Up Sage 300 ERP Security

On the Sage 300 ERP Administration screen, you can set up two levels of security: user level and database level.

- **User Level.** You use Sage 300 ERP user-level security to define a user’s access permissions for integrated screens, such as A/R Inquiry. These permissions apply to **all** Sage 300 ERP integrated databases except the databases specified in Sage 300 ERP Database-Level Security.

- **Database Level.** You use Sage 300 ERP Database-Level Security to define a user’s access permissions for integrated screens, such as A/R Inquiry, where the rights apply only to **one** Sage 300 ERP integrated database.

For example, assume you have integrated Sage CRM with two Sage 300 ERP databases: SAMINC and SAMLTD. You want user JOHN to have access to **all** Sage 300 ERP integrated screens (A/R Inquiry, A/R Invoice, and so on) while working with SAMINC. However, while working with SAMLTD, user JOHN should **not** have access to the A/R Inquiry screen.

In this case, you would use Sage 300 ERP User-Level Security to assign user JOHN permissions for **all** Sage 300 ERP integrated screens, which would apply to all integrated databases (SAMINC and SAMLTD). You would then use Sage 300 ERP Database-Level Security to revoke user JOHN’s access permissions for the A/R Inquiry screen for SAMLTD.

If customer 1200 existed in both SAMINC and SAMLTD, user JOHN would see the A/R Inquiry screen if viewing customer 1200 from SAMINC, but would not see the A/R Inquiry screen if viewing customer 1200 from SAMLTD.

## Setting Up Sage 300 ERP User-Level Security

On the Sage 300 ERP Administration screen, Sage 300 ERP User-Level Security allows you to assign access permissions for integrated Sage 300 ERP screens for all users, and to assign permissions for specific integrated screens, such as A/R Inquiry, to individual users.

These rights apply to all Sage 300 ERP integrated databases except any databases you specify in Sage 300 ERP Database-Level Security.
Note: You can assign Sage CRM-related permissions for individual users on the Sage CRM Administration screen by clicking the Users button.

When you click Sage 300 ERP User-Level Security, a list of users appears.

You can use this screen to edit user permissions for integrated Sage 300 ERP screens for all databases (except any specified in Sage 300 ERP Database-Level Security).

To edit user permissions for integrated Sage 300 ERP screens for all databases:

1. On the Sage 300 ERP Administration screen, click the name of a user in the User Name column.

   The Sage 300 ERP User-Level Security tab appears.

2. To start editing permissions for a user, click the Change button.

3. Enter the user's Sage 300 ERP User ID and Password.

   Sage CRM uses this information to access Sage 300 ERP data.

   Note: The Sage 300 ERP User ID and Password must already exist in Sage 300 ERP.

4. Select and clear check boxes to set user permissions for integrated Sage 300 ERP screens.

5. When you have finished, click Save.

6. To return to the Sage 300 ERP Administration screen, click Continue.

Setting Up Sage 300 ERP Database-Level Security

On the Sage 300 ERP Administration screen, Sage 300 ERP Database-Level Security lets you assign access permissions for Sage 300 ERP integrated screens, such as A/R Inquiry, where the rights apply only to the specific user and Sage 300 ERP integrated database that you select.

When you click Sage 300 ERP Database-Level Security, the following screen appears if there are users set up for database-level security:
If no users have been set up, the Sage 300 ERP Database-Level Security tab appears.

**To edit user access permissions for an integrated Sage 300 ERP database:**

1. On the Sage 300 ERP Administration screen, click **Sage 300 ERP Database-Level Security**.

2. On the right sidebar, click **New**.

3. On the **User Name** list, select a user.

4. Click the Finder to the right of the **Sage 300 ERP Company Name** field, and then select a company on the list that appears.

5. Type the user’s Sage 300 ERP User ID and Password in the **Sage 300 ERP User ID** and **Sage 300 ERP Password** fields.

Sage CRM uses this information to access Sage 300 ERP data.

**Note:** The Sage 300 ERP User ID and Password must already exist in Sage 300 ERP.

6. Select and clear check boxes to set user permissions for integrated Sage 300 ERP screens.

7. When you have finished, click **Save**.

8. To return to the Sage 300 ERP Administration screen, click **Continue**.

**Setting Up User-Level Security on the Sage CRM User Record**

You can also set up user-level security directly on the Sage CRM user record. Note that this security layer is not a replacement for the Sage 300 ERP security; it is simply a way to show or hide a screen.

**To set up user-level security on the Sage CRM user record:**

1. On the Administration screen, click the **Users** button.

2. On the Users screen, click **Users**.

**Note:** Each user is set up in the Sage CRM Admin Users section. (For details, see the “User Administration” chapter in the Sage CRM System Administrator Guide.)

3. Add a new user or search for an existing user.
   - To add a new user, click **New** on the right sidebar.
Now You Can…

- To search for an existing user:
  i. Specify search criteria in the fields on the Find tab.
  ii. On the right sidebar, click **Find**.
  iii. On the User Details screen, click **Change**.

4. On the **More User Details** tab at the bottom of the screen (two **More User Details** tabs appear on this screen), enter the user’s Sage 300 ERP User ID and Password:

<table>
<thead>
<tr>
<th>More User Details</th>
<th>Sage 300 ERP Password:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company A/R Inquiry:</td>
<td>Company A/R Promote:</td>
</tr>
<tr>
<td>Company A/R Invoice UE:</td>
<td>Company A/R Receipt UE:</td>
</tr>
<tr>
<td>Company A/P Inquiry:</td>
<td>Company A/P Promote:</td>
</tr>
<tr>
<td>Company A/P Payment UE:</td>
<td>Company A/P Customers UE:</td>
</tr>
<tr>
<td>Company O/C Inquiry:</td>
<td>Company A/R Refund UE:</td>
</tr>
<tr>
<td>Company O/C Shipments UE:</td>
<td>Company O/C Order Entry UE:</td>
</tr>
<tr>
<td>Company O/C Invoice UE:</td>
<td>Company O/C Invoices UE:</td>
</tr>
<tr>
<td>Company P/O Inquiry:</td>
<td>Company P/O Requisition UE:</td>
</tr>
<tr>
<td>Company P/O Invoice UE:</td>
<td>Company P/O Return UE:</td>
</tr>
<tr>
<td>Company P/M Inquiry:</td>
<td>Company P/M Contracts UE:</td>
</tr>
<tr>
<td>Company R/A Inquiry:</td>
<td>Company R/A UE:</td>
</tr>
<tr>
<td>Company Optional Fields:</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You must enter a unique Sage 300 ERP User ID and Password even if security in Sage 300 ERP has been disabled.

5. Click check boxes to assign permissions for Sage 300 ERP integration functions that this user is allowed to perform.

6. Click **Save** to save your changes.

**Now You Can...**

- Install the Sage 300 ERP integration component.
- Activate Sage CRM within Sage 300 ERP.
- Set up Sage 300 ERP workstations.
- Explain integration options.
In this chapter you will learn how to:

- Identify how Sage CRM screens change after integration with Sage 300 ERP.
- View and modify company and opportunity information in Sage CRM.
- Promote Sage CRM customers or vendors to Sage 300 ERP.
- Create O/E quotes and orders in Sage CRM.
- Use Sage CRM Inquiry features.

Overview

After you integrate Sage CRM with Sage 300 ERP, new screens appear in Sage CRM that you can use to view and edit Sage 300 ERP information. Some existing Sage CRM screens are also updated to add new features that enable you to view and edit Sage 300 ERP information.

Refer to the following section “Integration Changes to Sage CRM Screens” for a summary of these changes.

Note: The integrated tabs and customer and vendor information are available only if you have set up the integration link and imported information from Sage 300 ERP.

Integration Changes to Sage CRM Screens

When you integrate Sage CRM with Sage 300 ERP, new screens are added to Sage CRM, and there are changes to the features and functionality of some existing screens. The following sections describe the new screens and changes to existing screens.
Sage CRM Tabs and Screens Added During Integration

When Sage CRM is successfully integrated with Sage 300 ERP, the following new tabs and screens appear in the Company context (when you have selected a company):

- Promote to Sage 300 ERP
- A/P Inquiry / A/R Inquiry
- Vendor Statistics / Customer Statistics
- Optional Fields
- P/O Inquiry / O/E Inquiry
- P/M Inquiry
- R/A Inquiry

*Note:* Except for the Promote to Sage 300 ERP screen, the above screens are specific to a Sage CRM system with Sage 300 ERP integration and appear only if the selected company is also a customer or vendor in Sage 300 ERP.

The following new tabs and screens appear in the Opportunity context (when you have selected an opportunity):

- Quotes (includes Quote Summary and Quote Entry screens)
- Orders (includes Order Summary and Order Entry screens)

The following table gives a brief overview of each screen and its function.

### Quotes

The Quotes screen lists Sage 300 ERP quotes for an opportunity, and allows you to create quotes, edit existing quotes, and review totals and other key information at a glance, all without opening Sage 300 ERP. On this screen, you can:

- View quote totals, including the amount promoted to Sage 300 ERP orders.
- View information about all quotes created for the opportunity, including associated orders, expiration dates, and whether each quote is included in opportunity totals.
- Click **New Quote** to create a new quote for an open opportunity in Sage CRM without opening Sage 300 ERP.
- Click an existing quote to open it in the Quote Entry screen, where you can view and edit details for the quote and specify whether to include it in opportunity totals.
Integration Changes to Sage CRM Screens

Orders

Select one or more quotes to promote to a Sage 300 ERP order.

The Orders screen lists Sage 300 ERP orders for an opportunity, and allows you to create orders, edit existing orders, and review totals and other key information at a glance, all without opening Sage 300 ERP. On this screen, you can:

- View order totals, including order amount, shipment amount, and invoice amount.
- View information about all orders created for an opportunity, including document number, associated quotes, and whether an order is on hold.
- Click **New Order** to create a new order for an active customer in Sage CRM without opening Sage 300 ERP.
- Click an order to open it in the Order Entry screen, where you can view and edit details for the order.

Promote To Sage 300 ERP

The Promote To Sage 300 ERP screen shows Sage 300 ERP details about an existing customer or vendor. You can use this screen to promote a Sage CRM company to a Sage 300 ERP customer or vendor.

A/R Inquiry (Customers)

The A/R Inquiry screen lists posted or unposted Accounts Receivable documents for a company.

You can view document details, create and edit documents, and display a list of applied transactions for a document. This tab appears only for companies with a Sage 300 ERP Customer Number.

A/P Inquiry (Vendors)

The A/P Inquiry screen lists posted or unposted Accounts Payable documents for a company. You can edit unposted documents and create new vendor documents in Sage 300 ERP.

Aging and Statistics: (Customers and Vendors)

The Customer (or Vendor) Statistics screen displays the following information for customer or vendor records:

- Credit information
- Aging information for outstanding amounts
- Totals for all documents posted to customer or vendor accounts
- Dates and amounts of the last documents posted to customer or vendor accounts

The tab also displays specialized information, such as national account information for a national account customer.
## Integration Changes to Sage CRM Screens

### Optional Fields
The Optional Fields screen lists optional fields that are defined in Sage 300 ERP for a customer or vendor, and lets you edit the optional fields.

### O/E Inquiry (Customers)
The O/E Inquiry screen displays the following menu items:
- All Orders (active, standing, future, quotes)
- Credit/Debit Notes
- All Shipments
- Pending Shipments
- Sales History
- Customer Price List
- Serial & Lot Number Sales History

Use these screens to view document details, open a document for editing, or create a new O/E document.

### P/O Inquiry (Vendors)
The P/O Inquiry screen displays the following menu items:
- All Orders (active, standing, future, blanket)
- Credit/Debit Notes
- All Receipts
- Pending Receipts
- Purchase History
- Vendor Contract Costs
- Requisitions
- Returns
- Serial & Lot Number Purchase History

Use this screen to view document details, open a document for editing, or create a new P/O document.

### P/M Inquiry (Customers & Vendors)
If you use Sage 300 ERP Project and Job Costing, the P/M Inquiry screen displays a menu that provides access to customer or vendor transaction history. For customers, the menu also provides access to contract estimates and lists of contracts by status (for example, open, inactive, or completed).
If you use Sage 300 ERP Return Material Authorization (RMA), the R/A Inquiry displays a menu allowing access to lists of active, completed, or all return authorizations.

On the R/A Inquiry screen for a customer, you can also create a return authorization. The R/A Inquiry tab for a vendor displays only those return authorizations with which the vendor has been associated.

**Changes to Existing Sage CRM Screens**

The following Sage CRM screens are modified during integration to provide additional features that enable further integration between Sage CRM and Sage 300 ERP.

- **Company Summary**
- **Opportunity Summary**

If you are viewing the Company Summary screen for an active customer, **New Quote** and **New Order** buttons appear on the right side of the screen.

When you click these buttons, Sage CRM automatically creates a new opportunity for the current company, and then opens a new quote or order that is linked to the new opportunity.

An **Item Inventory** button also appears on the Company Summary screen. You can click this button to look up inventory items, view available quantities, and create a new quote or order for an item.

**Note:** This button appears if **Opportunity O/E Inquiry** access permission is selected for the user and/or database. For information about security, see “Setting Up Sage 300 ERP Security” in Chapter 6.

The Opportunity Summary screen displays detailed, up-to-date information about opportunity status, quote totals, and order totals. Any changes made to the opportunity will appear here, whether those changes are made in Sage CRM or Sage 300 ERP.

As you create quotes and orders for an opportunity, the Status field is updated automatically to reflect the current status of the opportunity. The following fields also display detailed information about the opportunity:

- **Forecast.** The current value of the opportunity.
- **Quote Amount.** The sum of all quotes included in the opportunity.
- **Pending Amount.** The sum of all quotes included in the opportunity but not yet promoted to an order.
Viewing Company and Opportunity Information

- **Order Amount.** The sum of all orders for this opportunity that have not been shipped.
- **Shipment Amount.** The sum of all shipments for this opportunity that have not been invoiced.
- **Invoice Amount.** The sum of all invoiced shipments for this opportunity.

*Note:* Shipment and invoice amounts do not include any miscellaneous charge amounts added to the shipment or invoice.

Viewing Company and Opportunity Information

This section includes instructions for logging on to Sage CRM, viewing company and opportunity screens, and viewing and modifying information and totals for companies and opportunities.

**Logging On to Sage CRM**

If you are on the Sage CRM server, click **Start > Programs > Sage CRM > CRM** to log on. Otherwise, use the following procedure.

**To log on to Sage CRM:**

1. Open an Internet Explorer browser window.
2. In the address bar, type the URL of the Sage CRM installation.
   
   The URL depends on your computer name and install directory. For example, if your computer name is Sage300ERP, and you installed Sage CRM with the default installation name of CRM, type **http://Sage300ERP/CRM**.

   The Log On dialog box appears.
3. Type **admin** in the User Name field, and leave the Password field blank.
4. Click **Log On**.
   
   Sage CRM displays the splash screen or the My CRM work area.

**Specifying the Number of Rows that Appear in the Grid**

You can specify the number of rows displayed in the grid of any integrated Sage 300 ERP screen, such as A/R unposted invoices.
To specify the number of rows that appear in the grid:

1. On the Sage CRM Main Menu, click **My CRM**.
2. Click the **Preferences** tab.
3. In the **Grid Size** box, select the number of rows to display.

**Note:** To have access to My CRM, your User ID must be set up in the Users function to access My CRM Lists.

**Viewing and Modifying Company Information**

In Sage CRM, you use the tabs at the top of the screen to navigate to different program screens. The tabs that appear depend on the current context. This section describes the Company context.

**Viewing Company Tabs**

When you select a company, Sage CRM displays tabs that appear in the company context, including the Promote to Sage 300 ERP tab and the different Inquiry tabs.

**To view tabs in the Company context:**

1. On the left sidebar, click **Find**.
2. On the Find list at the top of the screen, select **Company**.
   
   A list of all companies appears. You can further narrow your search by entering the Sage 300 ERP Database ID, or a Sage 300 ERP Customer or Vendor Number.
3. On the right sidebar, click **Find**.
4. Select the company you want to view from the alphabetized list.

   The Company Summary page appears and the Company (or Vendor) context tabs are displayed.

   **Note:** Changes made to the following fields on the Company Summary page in Sage CRM are reflected in Sage 300 ERP when you click Save:

   - Tax Group
   - Group Code
   - Description
   - Website
   - Terms Code
• Address Fields
• Business Phone, Fax and E-mail fields
• Contact Information
• Company Name

**Specifying Sage 300 ERP A/R and A/P Person and Address Types**

The Person and Address edit screens include a series of check boxes that you can use to specify one or more types. When Sage CRM is integrated with Sage 300 ERP, new **Type** check boxes appear for contacts and addresses.

- If a person is a Sage 300 ERP A/P Contact, A/P Remit-To Contact, A/R Contact, or A/R Ship-To Contact, their contact information is synchronized between Sage CRM and Sage 300 ERP. Within the context of a company, only one person can have the Sage 300 ERP A/P or A/R Contact type selected. However, more than one person can be assigned as the ERP A/P Remit-To Contact (or A/R Ship-To Contact).

- If an address is a Sage 300 ERP A/P Address, A/P Remit-To Address, A/R Address, or A/R Ship-To Address, its information is synchronized with the address in the customer/vendor record.

- If an address is a Ship-To or Remit-To address, it is synchronized with A/R Ship-To or A/P Remit-To addresses. Within the context of a company, only one address can have the Sage 300 ERP A/R or A/P Address type selected. However, more than address can be assigned as the ERP A/P Remit-To Address (or A/R Ship-To Address).

**Note:** Ship-To and Remit-To addresses and contacts cannot be created in Sage CRM. Use Sage 300 ERP to create the addresses and contacts.

**Viewing and Modifying Optional Fields**

If you use optional fields in Sage 300 ERP Accounts Receivable or Accounts Payable, you can use the Optional Fields screen to view and modify the optional fields for a customer or vendor.

**To view optional fields for a company:**

1. Select a customer or vendor.
2. Click the Optional Fields tab.

The Optional Fields screen appears and displays Sage 300 ERP optional fields for the current company.
The screen displays all the optional fields defined for all customers (or vendors) for a company, as configured in the Optional Fields setup form in Sage 300 ERP Accounts Receivable (or Accounts Payable).

The Value Set and Auto Insert values reflect the values set in Sage 300 ERP. For descriptions of these fields, refer to the Sage 300 ERP documentation.

The optional fields that apply to the current customer (or vendor) are selected in the Field Exists check box.

3. To edit optional fields, click Change in the right sidebar.

The check boxes are available.

- Enter (or edit) a value, and then select both Value Set and Field Exists.

  **Note:** To save the value, you must select Value Set. You can clear the Value Set check box if the optional field has not been set up with a default value in Sage 300 ERP. If it is cleared, the field’s value will also be cleared.

- You must select the Field Exists box to apply an optional field (including a blank optional field if allowed) to the customer (or vendor). If you clear the check box, the optional field no longer applies to the customer or vendor.

- The Auto Insert label next to the Field Exists check box appears only for fields with Auto Insert set to ‘Yes’ in Sage 300 ERP, and is for display only. To change Auto Insert, use the Optional Fields setup form in Sage 300 ERP Accounts Receivable or Accounts Payable.

- Enter any Date or Number optional field in the format defined on the Preferences tab of My CRM.

- Enter any Time optional field in the following format: hh:mm:ss.

- Changes you make on this screen will be reflected in Sage 300 ERP records.

**Viewing Customer and Vendor Aging and Statistical Information**

You can view summary information for customers and vendors in the Company context from the Customer Statistics or Vendor Statistics tabs. These tabs are displayed only for companies with a Sage 300 ERP customer or vendor number.
To view credit information for a company:

1. Select a company.
   The Company Summary tab opens.

2. Click the Customer Statistics or Vendor Statistics tab.
   The Customer Statistics or Vendor Statistics screen opens with Sage 300 ERP credit information:

3. On the right sidebar, click Customer Activity or Vendor Activity.
   The Sage 300 ERP A/R Customer Activity or Vendor Activity form appears.

   On the Credit Information panel (top-left), you can:
   - Click the Customer Number link to open the Sage 300 ERP A/R Customers form (or for a vendor, click the Vendor Number link to open the Sage 300 ERP A/P Vendors form).
   - Click the Optional Fields link (where available) to view optional fields associated with the customer (or vendor).
   - If the customer is set up with a Sage 300 ERP A/R national account number, click the National Account link to open the Sage 300 ERP A/R National Accounts form.

   In the Aging panel at the top right, you can edit dates and values, and then click Run Aging in the right sidebar to recalculate the results.

   The Document Totals panel displays total values for different types of transactions. When you change the Fiscal Year, Fiscal Period, or Currency Type, the details refresh automatically.
• The first column lists document types.
• The second column lists totals for the selected period.
• The third column lists totals for the selected year, up to and including the selected period.
• The fourth column lists totals for the year previous to the selected year.

**Note:** You can display Documents Totals in either the customer/vendor currency or the functional currency.

The Document History panel shows statistics about the customer’s (or vendor’s) document history.

If the customer is set up with a Sage 300 ERP A/R national account number, national account information also appears at the bottom of the screen.

**Viewing and Modifying Opportunity Information**

In Sage CRM, you use the tabs at the top of the screen to navigate to different program screens. The tabs that appear depend on the current context. This section describes the Opportunity context.

**Viewing Opportunity Tabs**

When you select a company, Sage CRM displays tabs that appear in the opportunity context. This is the context in which the Quotes and Orders tabs appear, allowing you to view, create, and edit Sage 300 ERP quotes and orders.

**To view tabs in the Opportunity context:**

1. On the left sidebar, click **Find**.
2. On the Find list at the top of the screen, select **Company**. You can further narrow your search by entering criteria in the fields on the Find tab.
3. On the right sidebar, click **Find**.
4. Select the company you want to view from the alphabetized list.
5. Click the **Opportunities** tab.

The Opportunity Summary page appears, and the Opportunity context tabs are displayed.
Viewing and Modifying Opportunity Stage and Status

On the Opportunity Summary screen, you can view information about the current stage and status of an opportunity as it progresses through the sales cycle. This information is updated as changes are made in Sage CRM and Sage 300 ERP.

You can update the **Stage** and **Status** fields manually to show the current status of an opportunity, or if workflow is enabled, you can use the workflow bullets in the right sidebar to progress the opportunity.

After integration with Sage 300 ERP, these fields are updated as follows when you create an opportunity, create quotes, promote quotes to an order, or save an order that completes the opportunity:

- **Create a new opportunity.** When you click **New Quote** or **New Order** on the Company Summary screen, Sage CRM creates a new opportunity automatically. (You can create a new opportunity manually by right-clicking the **New** button on the right sidebar and selecting **Opportunity**.)
  - **Stage:** Lead
  - **Status:** In Progress

- **Create a new quote.** You can create a new quote by clicking **New Quote** on the Company Summary Screen or the Quotes tab (available when you are in the Opportunity context).
  - **Stage:** Proposal Submitted
  - **Status:** In Progress

- **Create a new order.** You can create a new order by clicking **New Order** on the Company Summary Screen or the Orders tab (available when you are in the Opportunity context).
  - **Stage:** Sale Agreed
  - **Status:** In Progress

- **Promote one or more quotes to an order.** On the Quotes tab (available when you are in the Opportunity context), you can select one or more quotes to promote to a Sage 300 ERP O/E order. When you save the order, a message appears that allows you to complete the opportunity.

  If you do **not** complete the opportunity, you can continue to create quotes and orders linked to that opportunity, and the **Stage** and **Status** fields are updated as follows:
  - **Stage:** Sale Agreed
- **Status:** In Progress

- **Complete an opportunity.** If you save an order and confirm that it completes the opportunity, the opportunity will be closed and you will not be able to create new quotes or orders without reopening it.

- **Stage:** Sale Agreed

- **Status:** Won

### Viewing Opportunity Forecast and Totals

On the Status tab of the Opportunity Summary screen, the **Forecast** field shows the current value of an opportunity as it progresses through the sales cycle. This information is updated as changes are made in Sage CRM and Sage 300 ERP.

- If the opportunity has quotes but no orders, this field shows total quote value.

- If the opportunity has one or more orders and its status is In Progress, this field shows total order value plus the value of quotes not yet promoted to an order.

- For any opportunity status, the amount displayed in this field is always displays the sum of Pending, Order, Shipment, and Invoice amounts.

On the Opportunity Totals tab, the **Amount** fields show detailed information to help you track the opportunity as it progresses through the sales process.

**Note:** Amounts for a quote are only included in opportunity totals if the **Include in Opportunity Totals** option is selected for the quote.

This ensures that opportunity totals do not show artificially inflated amounts. For example, if you create multiple versions of a quote, you may want to include only the most recent version in opportunity totals.

- **Quote Amount.** The sum of all quotes included in the opportunity.

- **Pending Amount.** The sum of all quotes included in the opportunity but not yet promoted to an order.

- **Order Amount.** The sum of all orders for this opportunity that have not been shipped.

- **Shipment Amount.** The sum of all shipments for this opportunity that have not been invoiced.
Importing National Accounts

- **Invoice Amount.** The sum of all invoiced shipments for this opportunity.

  **Note:** Shipment and invoice amounts do not include any miscellaneous charge amounts added to the shipment or invoice.

---

**Importing National Accounts**

When you use the Sage 300 ERP Administration screen to import national accounts, Sage CRM imports the National Account relationship from Sage 300 ERP. You can view these relationships on the Relationships screen.

If you make any change to a customer’s national account membership in Sage 300 ERP, the change will also appear in Sage CRM.

The main national account office must be a customer with the same customer number as the national account.

For example, the sample company SAMINC includes a national account called BARMART. The main national account office is a customer with customer number = “BARMART”. There are two national account “children” (members): Barmart San Diego (Customer 1100) and Barmart Oakland (Customer 1105).

After you import national accounts into Sage CRM, the following information will appear on the Relationships screen for the customer “BARMART”:

To see the “parent” national account for a customer, click on a national account member name.
Changing Customer and Vendor Numbers

To import a national account:
19. On the left sidebar, click **Sage 300 ERP Administration**.
   
   **Note:** This option only appears if you have administrative rights.

20. Click **Import National Accounts**.

21. Select a company and a range of relationships to import, or leave default settings in the **From** and **To** fields to import all relationships.

22. On the right sidebar, click **Import from Sage 300 ERP**.

Changing Customer and Vendor Numbers

Changes and Copies from Sage 300 ERP Customer Number Change and Sage 300 ERP Vendor Number Change can be synchronized to Sage CRM.

You can change a customer or vendor number in Sage 300 ERP and see those changes reflected in Sage CRM.

For example, if you use Customer Number Change to change a customer number to a new number, the customer number will also be updated to the new number in the Sage CRM company record.

You can also copy a customer or vendor number in Sage 300 ERP Customer Number Change and Sage 300 ERP Vendor Number Change and see those changes reflected in Sage CRM.

For example, if you use Customer Number Change to copy an existing customer number, both the original customer and the new copied customer will be available in Sage CRM.

**Note:** The ”combine” feature is not supported.

Promoting a Customer or Vendor to Sage 300 ERP

Use the Promote to Sage 300 ERP screen to promote a Sage CRM company to a Sage 300 ERP customer or vendor.

**Promoting a Company**

When you promote a company, Sage CRM automatically checks to see if the company already exists in Sage 300 ERP. If the company does not exist, you are prompted to add a unique Customer Number or Vendor Number and additional fields required by the Sage 300 ERP system.
To promote a company:

1. On the left sidebar, click **Find**.

2. On the Find list, select **Company**. You can specify additional criteria in the fields on this screen to narrow your search.

3. On the right sidebar, click **Find**.

   A list of companies that match your search criteria appears.

4. Select the company you want to promote.

   The Company Summary screen appears.

5. Click the **Promote To Sage 300 ERP** tab.

6. Select a Sage 300 ERP company database and click **Promote to Customer** (or **Promote to Vendor**) on the right sidebar.

   Depending on your choice, the New Customer or New Vendor screen appears.

   **Note:** Fields marked with an asterisk are mandatory.

7. Enter company details for the company on each tab.

   **Note:** To change the tax class or set the tax status for the new customer or vendor, click **Show Tax Classes** on the right sidebar.

   You can select up to five salespersons and their sales split if you are promoting a company to customer.

   The Optional Field Values section displays all the optional fields defined for all customers (or vendors) in a company. Enter optional field information for a vendor or customer in this screen to apply options to the current customer or vendor.

8. On the right sidebar, click **Promote to Customer** (or **Promote to Vendor**).

   - The company is promoted to Customer or Vendor status, and company details are available in both Sage CRM and Sage 300 ERP.

   - Company type is set to Customer or Vendor, and the Customer Number, Credit Limit, Group Code, Tax Group and Terms Code fields are added to the screen. The Customer Type, Sage 300 ERP Customer Number, and Credit Limit are read-only.
The customer number of any opportunity-linked Order Entry quotes, orders, shipments, and invoices assigned to the company is updated to reflect the new customer number.

Changing a Customer or Vendor Link

If you have used the Import Customers or Import Vendors feature on the Sage 300 ERP Administration screen to import an existing customer or vendor into Sage CRM from Sage 300 ERP, the Sage 300 ERP Customer/Vendor Integration tab appears on the Promote To Sage 300 ERP screen:

- You can click the **Change Customer/Vendor Link** button to change the Customer Number or Vendor Number.
- If you need to delete a customer or vendor in Sage 300 ERP but keep the customer in Sage CRM, you can click the **Unlink this Customer/Vendor** button to delete the existing Customer/Vendor Number.

Looking Up Inventory Items

After integrating Sage CRM with Sage 300 ERP Product Update 1 or later, you can look up Sage 300 ERP inventory items from the Company Summary screen in Sage CRM. This enables you to quickly look up an item, review available quantities, and create a new quote or order for an item.

The **Item Inventory** button appears on the Company Summary screen if both of the following conditions are met:

- The company you are viewing is a Sage 300 ERP customer. (The button does not appear when viewing other company types such as vendors, or when viewing non-integrated companies.)
- **Opportunity O/E Inquiry** access permission is selected for the user and/or database. (For information about security, see “Setting Up Sage 300 ERP Security” in Chapter 6.)

Before you can create a new quote or new order for an item from the Sage CRM Item Inventory screen, default values must be specified in Sage 300 ERP for the following O/E Order Entry fields:

- **Price List.** Price list is defaulted by the following selections, listed in order of precedence from lowest to highest:
  - O/E Options (price list associated with the selected **Default Template Code**
Looking Up Inventory Items

- I/C Items (Default Price List)
- A/R Customers (Customer Price List)
- A/R Ship-To Locations (Customer Price List for the customer's primary ship-to location)

- **Location.** Price list is defaulted by the following selections, listed in order of precedence from lowest to highest:
  - O/E Options (location associated with the selected Default Template Code)
  - A/R Customers (Inventory Location)
  - A/R Ship-To Locations (customer's primary ship-to location)

- **Any automatically inserted optional fields.** If you use Transaction Analysis and Optional Field Creator, ensure that all optional fields with Auto-Insert set to Yes are set up as follows:
  - Value Set set to Yes.
  - Default Value defined.

---

**Note:** You should set up I/C Item Pricing or I/C Contract Pricing for all potential pricing combinations. If you do not, when you create a quote or order from the Item Inventory screen, the default price for the added item may be set to zero.

---

**To look up inventory items:**

1. Select a Sage 300 ERP company.

2. On the Summary screen, in the right sidebar, click Item Inventory.

   The Find screen appears.

3. In the Item Keyword field, type part or all of the item number or description.

   The following special characters are Sage 300 ERP item number separators: -/\*.()#. These characters are excluded when searching against the item number, but are used when searching against item description.

   The percent sign (%) and underline (_) are used as wildcard characters. The percent sign matches any sequence of characters, whereas the underline matches any single character.

   The open square bracket ([]) is a special reserved character that should not be used in search criteria. It will return no results, even if present in the item number or description.
4. Click **Find**.

   Items that match the text you entered appear in the Item Inventory table, with available quantities displayed in the **Total Quantity Available** column.

5. To create a new quote or order for an item:
   
   a. In the Item Inventory table, click the **New Quote** or **New Order** icon in the row for an item.

      Sage CRM creates a new opportunity for the quote or order. The Quotes screen or Orders screen appears, with a detail line added for the item you selected.

   b. Review document details, company details, custom fields (if you use them), and sales split information (if you assign sales splits).

   c. Review and change information for the item included in the quote or order, such as quantity, price, and discount.

   d. Enter any additional line items to be included in the quote or order.

   e. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

   f. When you have finished creating the quote or order, click the **Save** button in the right sidebar.

      Sage CRM creates the quote or order, links it to the new opportunity, and displays the document in read-only mode.

After creating the quote or order, you can:

- Click **Edit** to edit the quote.
- Click **Print** to print the quote.
- Click **Continue** to view the Quote Summary or Order Summary screen, which displays all quotes or orders linked to the new opportunity.

For more information about creating quotes and orders in Sage CRM, see the next section in this chapter, “Creating and Working with O/E Quotes and Orders.”
Creating and Working with O/E Quotes and Orders

After integrating Sage CRM with Sage 300 ERP, you can view, edit, create, and save O/E quotes and orders in Sage CRM without using Sage 300 ERP forms.

**LanPak licenses**

You do not need a LanPak license to use the integrated Sage CRM Quote and Order screens described in this section, which you can use to view, edit, create, and save O/E quotes and orders in Sage CRM without opening Sage 300 ERP forms.

You can also use the Sage 300 ERP Inquiry screens described in the “Using Sage 300 ERP Inquiry Features” section of this chapter, such as P/O Inquiry and R/A Inquiry, without a LanPak license. However, you do require a LanPak license to use any of the integrated Sage 300 ERP forms that can be launched from the Inquiry screens, such as A/R Invoice Entry.

**Date format**

On entry and summary screens for quotes and orders, dates appear based on the format specified in the language settings for your browser. This means that dates on these screens may appear in a different format than dates on other Sage CRM screens, where date formatting is based on your Sage CRM preferences.

To change browser language settings:

1. In Internet Explorer, click Tools > Internet Options.
2. On the General tab, click Languages.
3. Click Add, and then select a language.
4. Save your settings.

The new language settings are applied, including date formatting if applicable.

To specify date format in Sage CRM:

1. Right-click My CRM, and then select Preferences.
2. Click Change.
3. On the Date/Time Preferences tab, select a format from the Date Format list.
4. Click Save.

**Creating a New Quote**

In Sage CRM, quotes are linked to sales opportunities. You can create a new Sage 300 ERP O/E quote for a company, whether the company is a
Sage 300 ERP customer or a non-existent customer (a customer that exists in Sage CRM but not in Sage 300 ERP).

If you create a quote for a non-existent customer, Sage CRM assigns the customer number CRM999999999 for the new quote. If the customer is promoted to Sage 300 ERP at a later date (either in Sage CRM or in Sage 300 ERP), this number is changed to the new customer number assigned in Sage 300 ERP.

**To create a quote for an existing opportunity:**

1. Select a company.
2. Click the **Opportunities** tab.
   
   A list of opportunities for the selected company appears.
3. Select an opportunity.
   
   The Opportunity Summary screen appears.
4. On the Opportunity Summary screen, click the Quotes tab.
   
   The Quote Summary screen appears.
5. In the right sidebar, click **New Quote**.
   
   The Quote Entry screen appears.

   **Note:** If the company is not a Sage 300 ERP A/R customer, and has not been linked to a Sage 300 ERP database, you will be asked to select a Sage 300 ERP database to which to link this company.

6. On the Document Details tab, select the **Include in Opportunity Totals** option if you want totals from this quote to be included in the amounts that appear on the Opportunity Summary and Quote Summary screens. If you are creating multiple versions of a quote, you may want to select this option for only one version.

7. On the Quote Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.

8. If you use custom fields or track sales commissions, review and edit information on the Custom Fields and Sales Split panels as needed.

9. On the Quote Details tab, enter line items to be included in the quote. Note the following considerations:

   - After you make **any** changes to a quote, you must click the **Refresh** button (to the right of the Quote Total) if you want to view the updated information in the Totals section. The results of
the changes you make will not be displayed in subtotals, order discounts, tax amounts, or quote totals until you click this button.

- To change the order of columns that appear in the grid, click the View menu and then drag and drop items in the list that appears. The item at the top of the list will appear as the left-most column in the grid, and so on.

- To add comments for customers, click the Add Comments link in the Comments column. Comments will appear on the printed version of the quote.

- To add instructions for Sage CRM and Sage 300 ERP users, click the Add Instructions link in the Instructions column. Instructions will not appear on the printed version of the quote.

10. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

**Note:** If you specify an order discount in the totals area, the discount applies only to the item subtotal and is not applied to any miscellaneous charges.

If you want to apply an order discount to miscellaneous charges, open the document in Sage 300 ERP, select the Discount Miscellaneous Charges option on the Totals tab, and post the document.

11. When you have finished creating the quote, click the Save button in the right sidebar.

Sage CRM creates the quote, links it to the currently selected opportunity, and displays the quote in read-only mode.

After creating the quote, you can:

- Click Edit to edit the quote.
- Click Print to print the quote.
- Click Continue to view the Quote Summary screen, which displays all quotes linked to the currently selected opportunity. On this screen, you can review existing quotes, create new quotes, or select one or more quotes to promote to a new Sage 300 ERP O/E order.

**To create a quote and link it to a new opportunity:**

1. Select a company.

2. In the right sidebar, click New Quote.
Creating and Working with O/E Quotes and Orders

Note: The New Quote button appears only if the company you selected is an active company.

Also, if the company is not a Sage 300 ERP A/R customer and has not been linked to a Sage 300 ERP database, you will be asked to select a Sage 300 ERP database to which to link this company.

Sage CRM creates the new opportunity automatically in the background, and the Quote Entry screen appears.

3. On the Document Details tab, select the Include in Opportunity Totals option if you want totals from this quote to be included in the amounts that appear on the Opportunity Summary and Quote Summary screens. If you are creating multiple versions of a quote, you may want to select this option for only one version.

4. On the Document Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.

5. If you use custom fields or track sales commissions, review and edit information on the Custom Fields and Sales Split panels as needed.

6. On the Quote Details tab, enter line items to be included in the quote.

Note: After you make any changes to a quote, you must click the Refresh button (to the right of the Quote Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or quote totals until you click this button.

7. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

Note: If you specify an order discount in the totals area, the discount applies only to the item subtotal and is not applied to any miscellaneous charges.

If you want to apply an order discount to miscellaneous charges, open the document in Sage 300 ERP, select the Discount Miscellaneous Charges option on the Totals tab, and post the document.

8. When you have finished creating the quote, click the Save button in the right sidebar.

Sage CRM creates the quote, links it to the new opportunity, and displays the quote in read-only mode.

After creating the quote, you can:
• Click Edit to edit the quote.
• Click Print to print the quote.
• Click Delete to delete the quote.
• Click Continue to view the Quote Summary screen, which displays all quotes linked to the new opportunity. On this screen, you can review existing quotes, create new quotes, or select one or more quotes to promote to a new Sage 300 ERP O/E order.

Viewing and Editing Existing Quotes

On the Quote Summary screen, you can view information about existing quotes for an opportunity, including associated orders, expiration date, and whether each quote is included in totals for the currently selected opportunity.

You can click the document number for a quote to view additional details, and if the opportunity has not been completed or expired, you can edit quote details.

To view and edit quote details:

1. Select an opportunity.
2. Click the Quotes tab.

   The Quote Summary screen appears.
3. In the Document Number column, click a link.

   The quote you selected opens in read-only mode in the Quote Entry screen.
4. If the selected company is an active customer and the opportunity has not been completed, you can click the Edit button in the right sidebar to edit quote details.

   **Note:** After you make any changes to a quote, you must click the Refresh button (to the right of the Quote Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or quote totals until you click this button.

5. When you have finished editing, click Save to save your changes.
Creating and Working with O/E Quotes and Orders

Promoting Quotes to an Order

In Sage CRM, you can create a new Sage 300 ERP O/E order by selecting one or more quotes you have created for an opportunity, and then promoting those quotes to a new order.

If you create a quote or an order for a non-existent customer (a customer that exists in Sage CRM but not in Sage 300 ERP), Sage CRM assigns the customer number CRM999999999 to the new order. If the customer is promoted to Sage 300 ERP at a later date, this number is changed to the new customer number assigned in Sage 300 ERP.

**Note:** For information about promoting a Sage CRM customer to Sage 300 ERP, see the previous section in this chapter, “Promoting a Customer or Vendor to Sage 300 ERP.”

You cannot promote a quote to an order if any of the following conditions apply:

- The quote has expired
- The quote has already been promoted to an order
- The opportunity is closed (in this case, no quotes linked to the opportunity can be promoted to an order unless you reopen the opportunity)

When you save the new order that is created from the quote or quotes you selected, a message asks if this order completes the opportunity. If you complete the opportunity:

- Sage CRM sets the opportunity’s status to Won
- You cannot add new quotes to the opportunity unless you reopen it
- All promoted quotes are now included in opportunity totals, regardless of whether you selected the **Include in Opportunity Totals** option when creating or editing the quotes.
- All quotes that have not been promoted to an order will no longer be included in opportunity totals.

After you promote quotes to a new order, Sage CRM updates the forecast and total amounts on the Quote Summary, Order Summary, and Opportunity Summary screens as described earlier in this chapter in the section “Viewing Opportunity Forecast and Totals.” All quotes that were promoted to create the order appear in the **Associated Quotes** column on the Orders tab.

**To promote one or more quotes to an order:**

1. Select an opportunity.
2. Click the **Quotes** tab.

   The Quote Summary screen appears.

3. In the left column, click one or more check boxes to select the quote or quotes you want to promote to an order.

   **Note:** You cannot select quotes that have expired, or quotes that have already been promoted to an order.

4. In the right sidebar, click **Promote to Order**.

   Sage CRM creates a new O/E order from the quotes you selected. The order is added to the Sage 300 ERP O/E system.

   If the company linked to the current opportunity is a Sage 300 ERP O/E customer, the Sage 300 ERP customer number appears automatically in the Customer Number field.

   If the company linked to the current opportunity is a non-existent customer (a customer that exists in Sage CRM but not in Sage 300 ERP), Sage CRM assigns the customer number CRM999999999 for the new order.

5. A message appears, asking if this order completes the opportunity.

   - If the opportunity is complete and you will not need to create any more quotes or orders for it, click **Yes**.

     Sage CRM sets the opportunity’s status to Won and clears the **Include in Opportunity Totals** option for all quotes that were not promoted to an order. You cannot create new quotes or orders for the opportunity unless you reopen it.

   - If you may need to create more quotes or orders for the opportunity, click **No**.

     The opportunity’s status remains In Progress, and the **Include in Opportunity Totals** option is unchanged for any remaining quotes that have not been promoted to an order.

   The new order appears in read-only mode in the Order Entry screen.

   You can now:

   - Click **Edit** to edit order details.

   - Click **Continue** to view the Order Summary screen for the current opportunity.
Creating a New Order

You can create a new Sage 300 ERP O/E order for a company, whether the company is a Sage 300 ERP customer or a non-existent customer (a customer that exists in Sage CRM but not in Sage 300 ERP).

If you create an order for a non-existent customer, Sage CRM assigns the customer number CRM999999999 for the new order. If the customer is promoted to Sage 300 ERP at a later date (either in Sage CRM or in Sage 300 ERP), this number is changed to the new customer number assigned in Sage 300 ERP.

For information about promoting a Sage CRM customer to Sage 300 ERP, see the previous section in this chapter, “Promoting a Customer or Vendor to Sage 300 ERP.”

The following procedure describes creating a new order for an existing Sage CRM opportunity. If you want to create a new order by promoting one or more existing quotes to an order, see the previous section, “Promoting Quotes to an Order.” If you want to create a new order and link it to a new opportunity, see the next procedure in this section.

To create a new order for an existing opportunity:

1. Select a company.
2. Click the Opportunities tab.
   A list of opportunities for the selected company appears.
3. Select an opportunity.
   The Opportunity Summary screen appears.
4. On the Opportunity Summary screen, click the Orders tab.
   The Order Summary screen appears.
5. In the right sidebar, click New Order.
   The Order Entry screen appears.

   Note: If the company is not a Sage 300 ERP A/R customer, and has not been linked to a Sage 300 ERP database, you will be asked to select a Sage 300 ERP database to which to link this company.

6. On the Document Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.
7. If you use custom fields or track sales commissions, review and edit information on the Custom Fields and Sales Split panels as needed.
8. On the Order Details tab, enter line items to be included in the order. Note the following considerations:

- After you make any changes to an order, you must click the Refresh button (to the right of the Order Total) if you want to view the updated information in the Totals section. The results of the changes you make will not be reflected in subtotals, order discounts, tax amounts, or order totals until you click this button.

- To change the order of columns that appear in the grid, click the View menu and then drag and drop items in the list that appears. The item at the top of the list will appear as the left-most column in the grid, and so on.

- To add comments for customers, click the Add Comments link in the Comments column. Comments will appear on the printed version of the order.

- To add instructions for Sage CRM and Sage 300 ERP users, click the Add Instructions link in the Instructions column. Instructions will not appear on the printed version of the order.

9. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

Note: If you specify an order discount in the totals area, the discount applies only to the item subtotal and is not applied to any miscellaneous charges.

If you want to apply an order discount to miscellaneous charges, open the document in Sage 300 ERP, select the Discount Miscellaneous Charges option on the Totals tab, and post the document.

10. When you have finished creating the order, click the Save button in the right sidebar.

Sage CRM displays the order in read-only mode, saves the order in Sage CRM and Sage 300 ERP, and updates the forecast and total amounts on the Order Summary and Opportunity Summary screens as described earlier in this chapter in the section “Viewing Opportunity Forecast and Totals.”

After creating the order, you can:

- Click Edit to edit the order.
- Click Print to print the order.
- Click Delete to delete the order.
Creating and Working with O/E Quotes and Orders

- Click **Continue** to view the Order Summary screen, which displays all orders linked to the new opportunity.

**To create a new order and link it to a new opportunity:**

1. Select a company.

   The Company Summary screen appears.

2. In the right sidebar, click **New Order**.

   Sage CRM automatically creates a new opportunity in the background, and then creates the order and links it to the new opportunity. The order appears in the **Order Entry** screen.

   If the company is a Sage 300 ERP A/R customer, the Sage 300 ERP customer number is added automatically to the Customer Number field in Sage 300 ERP.

   If the company is a non-existent customer (a customer that exists in Sage CRM but not in Sage 300 ERP) and has not been linked to a Sage 300 ERP database, Sage CRM asks you to link the company to a Sage 300 ERP database.

3. On the Document Details and Company Details tabs, check that the displayed information is correct, and make changes as needed.

4. If you use custom fields or track sales commissions, review and edit information on the Custom Fields and Sales Split panels as needed.

5. On the Order Details tab, enter line items to be included in the quote.

   **Note:** After you make *any* changes to an order, you must click the **Refresh** button (to the right of the Order Total) if you want to view the updated information in the Totals section. The results of the changes you make will **not** be reflected in subtotals, order discounts, tax amounts, or order totals until you click this button.

6. In the totals area at the bottom of the screen, enter a discount (if applicable) and check that the other information displayed here is correct.

   **Note:** If you specify an order discount in the totals area, the discount applies only to the item subtotal and is **not** applied to any miscellaneous charges.

   If you want to apply an order discount to miscellaneous charges, open the document in Sage 300 ERP, select the **Discount Miscellaneous Charges** option on the Totals tab, and post the document.
7. When you have finished creating the order, click the **Save** button in the right sidebar.

Sage CRM displays the order in read-only mode, saves the order in Sage CRM and Sage 300 ERP, and updates the forecast and total amounts on the Order Summary and Opportunity Summary screens as described earlier in this chapter in the section “Viewing Opportunity Forecast and Totals.”

After creating the order, you can:

- Click **Edit** to edit the order.
- Click **Print** to print the order.
- Click **Delete** to delete the order.
- Click **Continue** to view the Order Summary screen, which displays all orders linked to the new opportunity.

**Viewing and Editing Existing Orders**

If Sage 300 ERP O/E orders exist for a company and are linked to a Sage CRM opportunity, you can view and edit those orders in Sage CRM.

**To view and edit an order:**

1. Select an opportunity.
2. Click the **Orders** tab.
   
The Order Summary screen appears.
3. Click the linked number in the **Document Number** column.
   
The order appears in the Order Entry screen.
4. In the right sidebar, click **Edit**.

**Note:** After you make any changes to an order, you must click the **Refresh** button (to the right of the Order Total) if you want to view the updated information in the Totals section. The results of the changes you make will **not** be reflected in subtotals, order discounts, tax amounts, or order totals until you click this button.

5. Edit the order as needed, and when finished, click **Save**.

Sage CRM and Sage 300 ERP are updated with the new information for the order.
About Sales Splits

On the Quotes and Orders tabs, you can use the Sales Split panel to calculate sales commissions by allocating transaction totals to up to five salespersons.

You can assign portions of each transaction to the salesperson or salespersons responsible for the customer account or sale. If you track commissions for sales staff, Sage 300 ERP Order Entry uses this information to update commission data when you post invoices and run Day End Processing.

When you enter a transaction, the salespersons assigned to the customer account in Sage 300 ERP Accounts Receivable appear on the Sales Split panel by default. If you select a ship-to location, the salespersons associated with that ship-to location are used instead.

Note: You assign default salespersons to customer records and to ship-to locations in Accounts Receivable.

The salesperson listed on the first line in the table is the primary salesperson for the transaction. If you specify a sales split, you must specify a primary salesperson.

You can assign the transaction to other salespeople by changing the percentage of the transaction total allocated to each salesperson. The amounts in the Percentage column must total 100 (or 0 if you do not assign salespeople to the transaction).

Using Sage 300 ERP Inquiry

After integration, Sage 300 ERP Inquiry tabs appear in Sage CRM when you are in the Company context (after you select a company). You can use these screens to review information and perform a wide variety of tasks that use information from the Sage 300 ERP system.

Note: These screens include many features that open integrated Sage 300 ERP forms. For example, the A/R Inquiry and O/E Inquiry screens include buttons and links that open Sage 300 ERP forms.

To open integrated Sage 300 ERP forms, you need a LanPak license. However, you do not need a LanPak license to use the integrated Quote and Order screens in Sage CRM.

To view Inquiry screens:

1. On the left sidebar, click Find.
2. On the Find list at the top of the screen, select Company. You can specify additional criteria in the fields on this screen to narrow your search.

3. On the right sidebar, click Find.

A list of companies that match your search criteria appears.

4. Select the company you want to view from the alphabetized list.


6. Click an Inquiry tab for a list of the information you can view.

**Order Entry (O/E) Inquiry**

You can view and modify Order Entry documents within the context of a customer from the O/E Inquiry tab. This tab appears only for companies with a Sage 300 ERP customer number.

**Viewing, Modifying, or Creating Order Entry Transactions**

On the O/E Inquiry screen, you can view, modify or create customer orders, shipments or invoices.

When you select All Orders, the Transactions screen appears with a list of orders for the current customer.

---

**Note:** You can use the Filter tab to refine the list of orders on this page.

**To create a new order from the Transactions page:**

1. On the right sidebar, click New.

2. The Sage 300 ERP O/E (or P/O) Order Entry form opens.

3. Complete the form.

4. Click Add.

**Order Number**

To edit or view an order in the list, click the Order Number link. This opens the Sage 300 ERP O/E Order Entry form in a new window.

**Drill Down**

To view an order in more detail, click its Drill Down button. This opens the Order Detail form.
Using Sage 300 ERP Inquiry

The Order Detail form consists of these sections:

- The **Order Information** section displays order header information, such as order total and order date.
- The **Order Details** section (line items) appears below the order header.
- The **Shipments** section (if any) shows all shipping information for the order.

**Note:** On a vendor’s Purchase Order Detail form, a Receipts section appears (if it exists) instead of a Shipments section.

On the Order Detail form, you can do the following:

- To display a form with ship-to and bill-to address information, click the **Shipping & Billing Addresses** button.
- To create a new shipment record, click the **New Shipment** button. This opens the Sage 300 ERP O/E Shipment Entry form in a new window.
- To edit or view the order, click the **Edit** button or the **Order Number** link in the Order Information (header) section of the Order Detail form. This opens the Sage 300 ERP O/E Order Entry form in a new window.
- Click **Sales Split** in the right sidebar to display the sales persons and their sales split percentages for the transaction.
- Click the **Optional Fields** link (where available) on the order header to view the optional fields associated with the order. You cannot edit the fields.
Using Sage 300 ERP Inquiry

Click any active link in the Optional Fields column of the Order Detail form to view the optional fields for the order detail line.

- To view more details about a location listed on the Order Detail form, select a link in the Location column. Details appear in the Location Information tab.
- Click any active link in the Item column of the Order Detail form to open the Item Detail form. This form shows general information about the item, as well as its details at each inventory location.
- To view detailed information regarding serial and lot numbers, click the link on the detail line (where available). This displays serial and lot information for the detail line.

**Note:** An asterisk (*) indicates the location (or bill of materials or kit) associated with the item. For example, if you are viewing a customer’s sales order, an asterisk indicates the location from which the item is shipped.

Open the Item Detail form by clicking the **Item Number** link. In the top section of the Item Detail form, you can click links to more detailed information, such as:

- **Alternate Item Number (if available).** If you click this link, the alternate item number value moves to the Item Number field and the form displays information about the alternate item number.
- **Optional Fields.** This link displays more details about the item’s optional fields.
In the lower section of the Item Detail form, you can click any of the links to view details of the item at a specific location, such as:

- **(Location) Name.** This link displays more information about a location, such as its address and contact information.

- **Quantity on S/O (if not zero).** This column shows the total quantity of the item that’s entered on all sales orders for the selected location. If you click a link in this column, then you can view a list of all the sales orders that contain the item at that location:

- **Quantity on P/O (if not zero).** This column shows the total quantity of the item that’s entered on all purchase orders for the selected location. If you click a link in this column, then you can view a list of all the purchase orders that contain the item at that location:

You can click any of the links to obtain more details.

9. If the Order Detail form you are viewing contains a Shipment section, you can:

- Click the **Shipment Number** link to view the shipment details as entered in the Sage 300 ERP O/E Shipment Entry form.

- Click the **Drill Down** button to view a shipment’s details.

The Shipment Detail form appears. The Shipment Information section shows you the shipment’s header information. The Shipment Details (line items) section appears below the shipment header. The Invoices section shows all of the Order Entry invoices generated from the shipment.
Using Sage 300 ERP Inquiry

In the Shipment Information (header) section of the form, you can:

- Click the **Shipping & Billing Addresses** button to view the addresses.
- Click the **Edit** button, or the **Shipment Number** link, to view or edit the details in the Sage 300 ERP O/E Shipment Entry form. You can edit the shipment details only if the shipment is not yet completed.
- Click the **New Invoice** button to open the Sage 300 ERP O/E Invoice Entry form. You can create an invoice only if the shipment is not yet completed.
- Click the **Customer Number** link to view or edit the customer details in the Sage 300 ERP A/R Customers form.
- Click the **Optional** Fields link (in the header section of the form) to view the shipment’s optional fields.

In the Shipment Details section, you can:

- Click an **Item** link to open the Item Detail form.
- Click a **Location** link to open the Location Information form, which was described earlier.
- Click an **Order Number** link to view the order details in the Sage 300 ERP O/E Order Entry form.
- Click the **Serial or Lot Numbers** link (where available) to view detailed information about serial or lot numbers for the transaction.

In the Invoices section you can:
- Click an **Invoice Number** link to view the invoice details in the Sage 300 ERP O/E Invoice Entry form.

- Click the **Drill Down** button to view an invoice’s details. The Invoice Detail form appears. Invoice Information shows you the Order Entry invoice header information. The line items appear below the invoice header.

- Click **Shipping & Billing Addresses** in the right sidebar to view the addresses.

- Click **Edit** in the right sidebar or the **Invoice Number** link to view or edit the invoice. This opens the Sage 300 ERP O/E Invoice Entry form.

- Click any link to view more information. For example, in the Invoice Information (header) section, you can click the **Location** link to view location information.

In the Invoice Details grid, you can:

- Click the following links (where available): **Item, Location, Shipment Number** (opens the Sage 300 ERP O/E Shipment Entry form), and **Optional Fields**.

- Click the **Serial or Lot Numbers** links (where available) to view detailed information about serial and lot numbers for the transaction.

10. If you are viewing a vendor’s Purchase Order Detail form, you can drill down to the Receipt Detail form (instead of the Shipment Detail form), by clicking the **Receipt Number** link. The Receipt Detail form looks similar to the Shipment Detail form, with a header information section, item list, and invoices.

You can also:

- Drill down to any invoices for the receipt from the Receipt Information screen.
• Create a new receipt from the Purchase Order information screen or a new invoice from the Receipt Information screen:

![Receipt Information](image)

- Click **Edit** in the right sidebar or the Receipt Number link to edit the receipt.
- Click the **Serial or Lot Numbers** links (where available) to view detailed information about serial and lot numbers for the transaction.
- Click any link on the form to view or edit information.

**Creating a New Sales Order**

**To create a new sales order:**

1. On the O/E Inquiry tab, click **New Order**.

   The Sage CRM Order screen appears.

2. Complete the form.

3. Click **Post**.

**Tip:** You can create new orders, shipments, and invoices from the Drill Down screens for each of these transactions. For example, you can create a new shipment from the order Drill Down, or a new invoice from the shipment Drill Down.
Viewing Credit/Debit Notes

To view credit/debit notes:

1. Click the customer’s O/E Inquiry tab.

2. Select the **Credit/Debit Note** option. A list of credit/debit notes appears, if any.

3. To refine your list of orders displayed, you can choose to display only the orders that fall within the range of dates that you specify.

4. To create a credit or debit note, click **New** in the right sidebar.

5. To view or edit the credit or debit note, click the **Credit/Debit Note Number** link. This opens the Sage 300 ERP Credit/Debit Note Entry form.

6. Click the **Drill Down** icon to view a summary of the credit or debit note.

You can use the following features on this screen.

- Click **Edit** or the **Credit/Debit** link to view or edit the credit or debit note. This opens the Sage 300 ERP O/E Credit/Debit Note Entry form.

- Click any active link to view more details.

- For example, in the header section of the form, you can click the **Optional Fields** link (where available) to view optional fields for the overall credit/debit note. To view optional fields for the credit/debit detail line, click any **Yes** link in the Optional Fields column.

- In the detail section of the form, you can click the **Item** or **Location** link.
Viewing All Shipments

You can view all Sage 300 ERP O/E shipments, including those which do not have a corresponding order.

To view all shipments:

- On the O/E Inquiry screen, click All Shipments.

A list of all shipments appears.

Use the following features on this screen:

- **Filter.** Enter search criteria into the Filter tab to see specific shipments. Click Filter in the right sidebar.

- **Shipment Number.** Click the Shipment Number link to view details about the shipment number.

- **Drill Down.** Click the Drill Down icon to view detailed information for the shipment (or receipt). The Shipment Detail form opens.

  Click any link in the Drill Down form to view more detailed information about the shipment (or receipt).

  You can also create or view any invoices for each shipment from the shipment drill down.

Viewing Pending Shipments

You can view O/E Orders with pending shipments on the O/E Inquiry screen.

To view O/E pending shipments:

- On the O/E Inquiry screen, click Pending Shipments.

A list of pending shipments for the current customer appears.

You can use the following features on this screen:

**Filter.** To refine your list of displayed pending shipments, enter search criteria and click Filter in the right sidebar. For example:

- You can choose to display only the pending shipments that fall within the range of expected shipment dates, item numbers, or locations that you specify.

  **Note:** Filtering is done on a “per detail line” basis. For example, an order will be displayed in the list if one of its detail lines has an expected shipment date that falls within the specified expected shipment date range.
- In the **Order Type** field, you can choose the type of orders to display, or choose to display all orders.

**Order Number.** To edit an order in the list, click its **Order Number** link. This opens the Sage 300 ERP Order Entry form in a new window.

**Drill Down.** To view an order in more detail, click the **Drill Down** button for the order. This opens the Order Detail form.

Click any active link to view more details. For example:

- Click the Optional Fields link (where available), to view optional fields for the overall order. You can also click the Order Number link and Customer link to view information on the Sage 300 ERP forms.

- To display more information about an item or the location, click the link in the Item column or the Location column.

- In the On Purchase Order column, you can click any Yes link to view all the purchase orders that contain the item.

**Viewing Item Sales History**

**To view item sales history:**

1. Click the **O/E Inquiry** tab.
2. Select the Sales History option.
3. Specify filter criteria for the Item Sales you want to see.
4. In the right sidebar, click **Filter**.

If there are sold items that match your criteria, a list appears below the Filter tab.
5. Click any active link to view more details. For example, click the link in an item’s **Period** column to display sales history detail of the item during the selected period.

![Sales History Table]

Click any active link on this form to display more information. For example, click the **Trans. Number** link or the **Order Number** link to open the associated Sage 300 ERP Order Entry forms.

Click the **Serial or Lot Numbers** link (where available) to view detailed information about serial and lot numbers for this transaction.

**Note:** For O/E invoices and all P/O transactions which were upgraded from previous Sage 300 ERP versions, the serial and lot numbers links will display as “No” and will not be active.

### Viewing Customer Price List

This section describes the forms and procedures for the O/E Customer Price List option of the O/E Inquiry screen. The list displays item pricing information for items that are priced using the customer’s default price list.

You can click the **Drill Down** icon to display all pricing information including sale pricing and how discounts are calculated.

**To view customer price list:**

1. On the O/E Inquiry screen, click **Customer Price List**.

2. The customer price list appears and displays information including the current base price and sale price based on the customer’s default price list.
Using Sage 300 ERP Inquiry

You can now:

- Click the **Item Number** link to view details about the item.
- Click the **Drill Down** icon to view detailed pricing information.

**Viewing Serial and Lot Number Sales History**

This section describes the forms and procedures for the O/E Serial and Lot Number Sales History options of the O/E Inquiry screen.

The Serial and Lot Numbers menu displays transactions and transaction details for customer transactions with serials and lots.

**To view serial and lot number sales history:**

- On the O/E Inquiry screen, click Serial Number Sales History or Lot Number Sales History.

The Sales History screen appears.

You can now:

- **Filter.** Enter search criteria to refine the list of transactions displayed. Click **Filter** in the right sidebar.
- **Drill Down.** Click the **Drill Down** icon to view detailed information about the transaction.

**Purchase Orders (P/O) Inquiry**

You can view and modify Purchase Order documents from the P/O Inquiry tab within the context of a vendor. This tab appears only for companies with a Sage 300 ERP vendor number.
Creating a New Purchase Order

To create a new purchase order:

2. Complete the form.
3. Click **Post**.

**Tip:** You can create new orders, receipts, and invoices from the Drill Down screens for each of these transactions. For example, you can create a new receipt from the order Drill Down, or a new invoice from the receipts Drill Down.

Viewing Credit/Debit Notes

To view credit notes and debit notes:

1. Click a vendor’s P/O Inquiry tab.
2. Select the Credit/Debit Note option. A list of credit notes and debit notes appears, if available.
   - To refine the list of documents, you can display only the credit notes and debit notes that fall within a range of dates that you specify.
   - To create a credit note or debit note, click **New** in the right sidebar.
   - To view or edit the credit note or debit note, click the **Credit/Debit Note Number** link. This opens the Sage 300 ERP Credit/Debit Note Entry form.
   - Click the **Drill Down** icon to view a summary of the credit or debit note.
You can use the following features on this screen:

- Click **Edit** or the **Credit/Debit Number** link to view or edit the credit or debit note. This opens the Sage 300 ERP O/E Credit/Debit Note Entry form.
- Click any active link to view more details.

For example, in the header section of the form, you can click the **Optional Fields** link (if available) to view optional fields for the overall credit/debit note. To view optional fields for a detail line, click the **Yes** link (if available) in the Optional Fields column.
- Click the **Item** or **Location** link in the detail section of the form.

### Viewing All Receipts

This section describes the forms and procedures for the P/O All Receipts option of the P/O Inquiry screen.

**To view all receipts:**

- On the P/O Inquiry screen, click **All Receipts**.

A list of all receipts appears.

You can use the following features on this screen:

- **Filter.** Enter search criteria into the Filter tab to see specific shipments. Click Filter in the right sidebar.
- **Receipt Number.** Click the Receipt Number link to view details about the receipt.
- **Drill Down.** Click the **Drill Down** icon to view detailed information for the receipt. The Receipt Information form opens.

Click any link in the Receipt Information form to view more information about the receipt.

You can also create or view any invoices for each receipt from this form.

### Viewing Pending Receipts

This section describes the forms and procedures for the P/O Pending Receipts option on the P/O Inquiry screen.

**To view pending receipts:**

- On the P/O Inquiry tab, click **Pending Receipts**.
A list of pending receipts for the current vendor is displayed.

You can use the following features on this screen:

**Filter.** To refine your list of displayed pending receipts, enter search criteria in the Filter section, and then click the **Filter** icon on the right sidebar. For example:

- You can display only the pending receipts that fall within the range of expected arrival dates, item numbers, or locations that you specify.

  **Note:** Filtering is done on a “per detail line” basis. For example, an order appears in the list if one of its detail lines has an expected arrival date that falls within the range of arrival dates you specify.

- In the **Purchase Order Type** field, you can select one type of purchase order to display, or display all purchase orders.

**Order Number.** To edit an order in the list, select its Purchase Order Number link. This opens the Sage 300 ERP Purchase Order Entry form in a new window.

**Drill Down.** To view a purchase order in more detail, click the **Drill Down** icon for the order. This opens the Purchase Order Information form.

Click any active link to view more details. For example:

- Click the **Optional Fields** link (where available), to view optional fields for the overall order. You can also click the **Purchase Order Number** and **Vendor** links to view information on the respective Sage 300 ERP forms.

- To display more information about an item or a location, click the link in the **Item Number** column or the **Location** column.
Viewing Purchase History

To view purchase history:
1. Click the P/O Inquiry tab.
2. Select the Purchase History option.
3. Specify filter criteria for Purchase History items you want to see.
4. In the right sidebar, click Filter.

If purchased items exist that match the criteria you specified, a list appears below the Filter section.

5. Click any active link to view more details. For example, click the link in an item’s Fiscal Period column to display purchase history detail for the item during the selected period.

Click any active link on this form to display more information. For example, click the Document Number link to open the associated Sage 300 ERP Order Entry form.

Click the Serial or Lot Numbers link (if available) to view detailed information about serial and lot numbers for this transaction.

Note: For Purchase Orders transactions that were upgraded from versions earlier than Sage ERP Accpac 5.6, the serial and lot numbers links appear as “No,” and are not active.
Using Sage 300 ERP Inquiry

**Viewing Vendor Contract Costs**

This section describes the forms and procedures for the P/O Vendor Contract Costs option on the P/O Inquiry tab. The list displays item pricing information for items that are priced using the vendor’s default price list.

Click the **Drill Down** icon to display all pricing information, including how discounts are calculated, sale pricing, and contract pricing.

**To view vendor contract costs:**
1. On the P/O Inquiry tab, click **Vendor Contract Costs**.
2. The vendor contract costs appear with information including the current base price and sale price based on the vendor’s default price list.

You can now:
- Click the **Item Number** link to view details about the item.
- Click the **Drill Down** icon to view detailed pricing information.

**Viewing Serial and Lot Number Purchase History**

This section describes the forms and procedures for the P/O Serial and Lot Number Purchase History options of the P/O Inquiry tab.

**To view serial and lot number purchase history**
- On the P/O Inquiry tab, click **Serial Number Purchase History** or **Lot Number Purchase History**.

The serial or lot number purchase history screen is displayed.

You can now:
- **Filter.** Enter search criteria to refine the list of transactions displayed. Click **Filter** in the right sidebar.
- **Drill Down.** Click the **Drill Down** icon to view detailed information about the transaction.

**Viewing or Editing Requisitions**

**To view or edit requisitions:**
- On the P/O Inquiry screen, click **Requisitions**.

A list of requisitions for the current vendor appears.

You can use the following features on this screen:
Filter. To refine your list of documents displayed, enter search criteria, and then click Filter in the right sidebar. For example:

- To include completed documents in the list, select the Include Completed Transactions check box.
- You can choose to display only the requisitions that fall within the range of dates that you specify.

**New.** Click New in the right sidebar to create a new requisition. This opens the Sage 300 ERP P/O Requisition Entry form in a new window. Complete the form, and then click Add.

**Requisition Number.** To edit or view a requisition in the list, click the Requisition Number link. This opens the Sage 300 ERP P/O Requisition Entry form in a new window.

**Drill Down.** To view a requisition in more detail, click its Drill Down button. This opens the Requisition Information screen:

- To edit or view the requisition, click Edit in the right sidebar or the Requisition Number link. This opens the Sage 300 ERP P/O Requisition Entry form in a new window.
- To view vendor details, click the Vendor link to open the Sage 300 ERP A/P Vendors form in a new window.
- Click the Optional Fields link (where available) to view optional fields information.

On the Requisition Lines tab, click any link to view more information. For example:

- To view vendor details, click the Vendor link in the grid to open the Sage 300 ERP A/P Vendors form in a new window.
- To view more details about an item number or location, click its link.

**Viewing or Editing Returns**

**To view or edit returns:**
- On the P/O Inquiry screen, click Returns.
A list of returns for the current vendor appears.

You can use the following features on this screen:

**Filter.** To refine your list of documents displayed, enter the fields in the Filter section, and click the Filter button. For example:

- To include completed documents in the list, select **Include Completed Transactions**.

- You can choose to display only the returns that fall within the range of dates that you specify.

**New.** Click **New** in the right sidebar to create a new return. This opens the Sage 300 ERP P/O Return Entry form in a new window. Complete the form and click **Post**.

**Return Number.** To edit or view a return in the list, click this link. This opens the Sage 300 ERP P/O Return Entry form in a new window.

**Drill Down.** Click the **Drill Down** icon to view a return in more detail. This opens the Return Information screen:

On the **Return Information** screen:

- Click **Shipping & Billing Addresses** in the right sidebar to view the addresses.

- Click **Edit** or the **Return Number** link to view or edit the return. This opens the Sage 300 ERP P/O Return Entry form in a new window.

- Click the **Vendor** link to view vendor details. This opens the Sage 300 ERP A/P Vendors form in a new window.

- Click the **Optional Fields** link (if available) to view optional fields information.

On the **Return Lines** tab, click any link to view more information, such as the **Item Number** link or **Location** link.
Using Sage 300 ERP Inquiry

Accounts Receivable (A/R) and Accounts Payable (A/P) Inquiry

From the A/R Inquiry or A/P Inquiry screens, you can choose to display a list of posted documents or a list of unposted Accounts Receivable or Accounts Payable documents.

The procedures that follow describe A/R Inquiry features. The A/P Inquiry screen functions are similar, so you can also follow these procedures when you use A/P Inquiry.

Viewing Posted Transactions

To view posted transactions:

- On the A/R Inquiry screen, click **Posted Transactions**.

A list of posted Sage 300 ERP A/R documents (such as invoices, receipts, refunds, and so on) appears for the currently displayed customer.

You can use the following features on this form:

**Filter.** Enter filtering criteria to refine the list of documents displayed. Click **Filter** in the right sidebar.

**New Invoice / Receipt / Refund.** To create a new Sage 300 ERP A/R document, select one of the following choices from the right sidebar: **New Invoice**, **New Receipt**, or **New Refund**. Each choice opens the appropriate Sage 300 ERP Accounts Receivable form in a new window.

**Document Number link.** To edit or view the details of a document, click the **Document Number** link. This opens the document in the Sage 300 ERP A/R form.

**Applied Details.** To view a list of documents that have been applied to a given document, select the document’s Applied Details button. The Applied Details form appears.

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Check/Rcv No.</th>
<th>Posting Date</th>
<th>Amount</th>
<th>Transaction Type</th>
<th>Vender Customer No.</th>
<th>Reference Document No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debit Note Applied To</td>
<td>00018-001</td>
<td>Thu Jan 15 2020</td>
<td>520.78</td>
<td>Debit Note Applied To</td>
<td>71-244-002</td>
<td></td>
</tr>
<tr>
<td>Receipt</td>
<td>00018-002</td>
<td>Thu Jan 15 2020</td>
<td>2,110.36</td>
<td>Receipt - Posted</td>
<td>71010001000100010125</td>
<td></td>
</tr>
<tr>
<td>Discount</td>
<td>00018-003</td>
<td>Thu Jan 15 2020</td>
<td>3.57</td>
<td>Discount - Posted</td>
<td>71010001000100010132</td>
<td></td>
</tr>
</tbody>
</table>

You can click the **Reference Document No.** link to view the document details on the Sage 300 ERP A/R form.

**Drill Down.** To view a document in more detail, select its Drill Down button. The Document Details form is displayed.

The top portion of the form displays the document header information. The detail lines appear below the document header. All documents that have been applied to the document appear below the detail lines.
On this form you can:

- Click **Edit** or **New** on the right sidebar to edit or create a document. Either choice opens the associated Sage 300 ERP A/R (or A/P) form.

- Click the **Optional Fields** link (where available), to view optional fields associated with the overall document. You can also click the **Document Number** link to open the document in the Sage 300 ERP A/R (or A/P) form.

### Viewing Unposted Invoices

**To view unposted invoices:**

- On the A/R Inquiry screen, click **Unposted Invoices**.

A list of unposted A/R invoices appears for the currently displayed customer.

You can use the following features on this form:

- **New**: Click **New** on the right sidebar to create a new Sage 300 ERP A/R invoice. This opens the Sage 300 ERP A/R Invoice Entry form.

- **Document Number**: Click the **Document Number** link to edit or view the details of a document. The Sage 300 ERP A/R Invoice Entry form appears.

- **Drill Down**: To view a document in more detail, select its Drill Down button. The Document Details form appears.

You can use the following features on this form:

- **New**: Click **New** on the right sidebar to create a new Sage 300 ERP A/R invoice. This opens the Sage 300 ERP A/R Invoice Entry form.

- **Edit or view document**: Click **Edit** in the right sidebar or the **Document Number** link to edit or view the details of a document. This opens the document in the Sage 300 ERP A/R form.

- **Optional Fields**: Click the **Optional Fields** link (where available) to display optional fields information.
**Viewing Unposted Receipts**

**To view unposted receipts:**

- On the A/R Inquiry screen, click **Unposted Receipts**.

A list of unposted A/R receipts appears for the currently displayed customer.

You can use the following features on this form:

- **New.** Click **New** in the right sidebar to create a new Sage 300 ERP A/R receipt. This opens the Sage 300 ERP A/R Receipt Entry form.

- **Edit or view document.** Click the **Check/Receipt No.** link to edit or view the details of a document. This opens the document in the Sage 300 ERP A/R Receipt Entry form.

- **Drill Down.** Click the Drill Down icon to view a document in more detail. The Document Details form is displayed.

You can use the following features on this form:

- **New.** Click **New** in the right sidebar to create a new Sage 300 ERP A/R receipt. This opens the Sage 300 ERP A/R Receipt Entry form.

- **Edit or view document.** Click **Edit** in the right sidebar or the Document Number link to edit or view the details of a document. This opens the document in the Sage 300 ERP A/R form.

- **Optional Fields.** Click the **Optional Fields** link (where available) to display optional fields information.

**Viewing Unposted Refunds**

**To view unposted refunds:**

- On the A/R Inquiry screen, select Unposted Refunds.

A list of unposted A/R refunds appears for the currently displayed customer.

You can use the following features on this form:
New. Click New on the right sidebar to create a new Sage 300 ERP A/R refund. This opens the Sage 300 ERP A/R Refund Entry form.

Edit or view document. Click the Document Number link to edit or view the details of a document. This opens the document in the Sage 300 ERP A/R Refund Entry form.

Drill Down. Click the Drill Down icon to view a document in more detail, The Document Details form appears.

You can use the following features on this form:

- New. Click New in the right sidebar to create a new Sage 300 ERP A/R refund. This opens the Sage 300 ERP A/R Refund Entry form.

- Edit or view document. Click Edit in the right sidebar or the Document Number link to edit or view the details of a document. This opens the document in the Sage 300 ERP A/R form.

- Optional Fields. Click the Optional Fields link (where available) to display optional fields information.

Project and Job Costing (P/M) Inquiry

If you use Sage 300 ERP Project and Job Costing, you can view or modify Project and Job Costing contracts within the context of a company from the P/M Inquiry screen.

For a customer, the P/M Inquiry screen displays the following options:

For a vendor, the P/M Inquiry screen displays only the Transaction History option.
Creating a New Contract

To create a new contract:
1. Select a customer.
2. On the P/M Inquiry tab, click **New Contract**.
3. Complete the form.
4. Click **Add**.

Viewing and Editing Contracts

To view and edit contracts:
- On the P/M Inquiry screen, click **All Contracts**.

A list appears with all contracts for a customer.

Notes:
- If a contract does not have any projects, then the contract will not appear in the list.
- If a contract does not have any projects set for the contract customer, then the contract will not appear in the list.
- If a contract has projects that have been assigned multiple customers, you will see that contract displayed in the list when you choose to view all contracts for any of the associated customers.

You can do the following on this form:
- To refine the list of contracts displayed, enter search criteria in the filter and click **Filter** in the right sidebar. For example, you can choose to display only the documents that fit the contract status you specify, or that fall within the range of dates that you specify.
- Click **New** on the right sidebar to create a contract. This opens the Contract Maintenance form in a new window. Complete the form and click **Add**.
- Click the **Contract** link to view or edit a contract. This opens the Contract Maintenance form in a new window.
- Click the **Customer Number** link to view more customer information. This opens the Sage 300 ERP A/R Customers form.
- Click the **Drill Down** icon to view a summary of a contract. This opens the Contract Summary form, which displays contract information, and a list of projects associated with the contract.
Using Sage 300 ERP Inquiry

On the Contract Summary form, you can do the following:

- Click **Edit** in the right sidebar or the **Contract** link to view or edit the contract. This opens the Sage 300 ERP Contract Maintenance form.

- Click the **Optional Fields** link (where available) to view the optional fields associated with the contract.

- Click the **Customer** link to view customer information.

### Project Details

To view more details about a project, click a link in the **Project** column to open the following screen:
Using Sage 300 ERP Inquiry

Click the **Optional Fields** link (where available) to view the optional fields associated with the project. You can also click the **Contract** or **Customer** link to view contract or customer information.

The Project Detail form also lists transaction documents associated with the project.

To list only certain documents, specify filter criteria and click the **Filter** button. For example, to list only Accounts Receivable documents, select “A/R Only” in the **Applications** field.

You can view some documents, such as Accounts Receivable invoices, in a Sage 300 ERP form. To view these documents, click any active link in the **Document Number** column.

To view a summary of a transaction, click the **Drill Down** button to open the following form:

<table>
<thead>
<tr>
<th>Transaction Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contract</strong></td>
</tr>
<tr>
<td><strong>Number</strong></td>
</tr>
<tr>
<td><strong>Source Module</strong></td>
</tr>
<tr>
<td><strong>Transaction Type</strong></td>
</tr>
<tr>
<td><strong>Quantity</strong></td>
</tr>
<tr>
<td><strong>Extended Amount</strong></td>
</tr>
<tr>
<td><strong>Discount</strong></td>
</tr>
<tr>
<td><strong>Vendor</strong></td>
</tr>
<tr>
<td><strong>Optional Fields</strong></td>
</tr>
</tbody>
</table>

On the Transaction Information form, you can click any link to view more details. For example, you can click the **Contract** or **Customer** links, or the **Document Number** link (if available).

**Viewing Contract Transaction History**

**To view contract transaction history:**

- On the P/M Inquiry tab, click **Transaction History**.

The Transaction History screen appears.

For a contract with projects that have been assigned multiple customers, you can view the transaction history of that contract or project for any of the associated customers.

You can do the following on this form:

- To display only transactions of your choice, specify filter criteria and click the **Filter** button. For example, to display only transactions which originated in Purchase Orders, select **P/O Only** in the **Applications** field.
• Click a **Drill Down** icon for more information about a transaction. This opens the Transaction Information form.

• For more information about a contract, click the link in the **Contract** column to open the Contract Maintenance form in a new window.

• For more information about a document, click an active link in the **Document Number** column to open a Sage 300 ERP form in a new window.

• For more information about a resource, click an active link in the **Resource** column.

**Return Material Authorization (R/A) Inquiry**

If you use Sage 300 ERP Return Material Authorization (RMA), you can view or modify return authorization documents within the context of a company on the R/A Inquiry screen.

For a customer, the R/A Inquiry screen provides the following options:

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Return Authorizations</td>
<td>List all Return Authorizations.</td>
</tr>
</tbody>
</table>

**Note:** The R/A Inquiry screen does not provide the option to create a new return authorization for a vendor.

**Creating a New Return Authorization**

**To create a new return authorization:**

1. On the R/A Inquiry screen, click **New Return Authorization**.
   
   The Return Authorization form opens in a new window.

2. Complete the form and click Add.

You can also create a return authorization from the screen that lists return authorizations.

**Viewing or Editing Return Authorizations**

**To view or edit return authorizations:**

• On the R/A Inquiry screen, click **All Return Authorizations**.

A list of return authorizations appears.
You can do the following on this form:

- To refine your list of displayed transactions, enter search criteria in the filter and click **Filter** in the right sidebar. For example:
  - To include completed transactions in the list, select **Include Completed Transactions**.
  - Display only the transactions that fall within the range of dates that you specify.
- Create a return authorization for a customer by clicking **New** on the right sidebar to open the Return Authorization form in a new window, completing the form, and clicking **Add**.
- Use a Sage 300 ERP form to view or edit a return authorization by clicking the contract’s link in the **All Return Authorizations** column. This opens the Return Authorization form in a new window.
- Click the **Drill Down** icon to view a summary of a return authorization. This opens the Return Authorization Summary form, which displays the return authorization’s general information and detail lines.

On the Return Authorization Summary form, you can do the following:

- Click **Shipping & Billing Addresses** on the right sidebar to view shipping information.
- Click **Edit** on the right sidebar or the **RA Number** link to view or edit the return authorization.
- Click links in the Return Authorization Information section of the form to view more details about the customer or a document (such as the return authorization document, last customer order, customer credit note, or vendor return).
- Click the **Optional Fields** link (where available) to view optional fields for the return authorization.
- In the detail section of the form, click any links in the **Customer Original Invoice** column or **Vendor Original Receipt** column.
In the details section of the form, click the link in the **Item Number** and **Location** columns to open a form that displays more item information, and the locations where the item can be found.

**Solo Integration with Sage CRM**

The Sage CRM Solo client enables you to work with Sage CRM data offline and then synchronize that data with your Sage CRM database. Solo integration enables you to view Sage 300 ERP customers and vendors on the Solo client.

**Note:** Sage CRM Solo is only supported in the Sage CRM 7.1C or later.

**Notes on Using Solo client with Sage CRM**

- Integrated Sage CRM screens and Sage 300 ERP forms are only available online. You cannot access these screens and forms using the Solo client.

- You can only create and edit non-ERP Sage CRM data using the Solo client. If you attempt to create or edit Sage 300 ERP data, an error message will appear.

- If a Sage 300 ERP company does not have a contact, the company will not appear in the Solo client after synchronization.

- When you upgrade from a previous version of Sage CRM that uses Solo, you must follow the instructions for upgrading in “Option 2” of the *Sage CRM Solo Guide*. This involves uninstalling the old Solo client and installing the new one.

**If you need to reinstall Sage 300 ERP integration:**

1. Reinstall Sage 300 ERP integration.
2. Uninstall the Solo client (follow the steps in the *Sage CRM Solo Guide*).  
3. Restart the Solo workstation.
4. Recreate the snapshot on the server.
5. Reinstall the Solo client on the workstation.
6. Re-synchronize the data on the Solo client.
Now You Can...

- View and modify company and opportunity information in Sage CRM.
- Import national accounts.
- Change customer and vendor numbers.
- Create and work with O/E quotes and orders.
- Use Sage 300 ERP Inquiry features to view and edit documents and transactions.